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OBJECTIVES VOCABULARY

Upon completion of this lesson, you should be able to: Desktop
m  Start and shut down a computer correctly. Folder
B Use storage media to safely store and access data. Icons
B Open and close a window. Maximize
m Name the parts of a window. Menu
m Explain how to change the size of a window and M?r.‘“ F)ar
switch between open windows. Minimize
m Create and manage files and folders. Pointing device
Start and exit a software program. Fresiore
Scroll bar
Install new software.
Taskbar
Estimated Time: 1.5 hours .
Title bar
Toolbar
Window

Y ou have learned about computer hardware and software,
how a computer processes data, inputting and outputting information,
storing data, and the ways a user interfaces with a computer. Now it is time to apply this knowl-
edge and learn some essential skills for using a computer. It is important to know how to start and
shut down the computer correctly, so that no data is lost and no components are damaged. In
addition, managing files and folders that store data and the media where data is stored will
ensure that the information you input and process with the computer will be safe and accessible.
With a graphical user interface, opening and closing software programs and windows within the
programs can be accomplished with a click of your mouse. Installing new software is a straight-
forward task, too, with step-by-step instructions provided by the software’s setup program and
your computer’s operating system.


http://www.a-pdf.com/?product-split-demo
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Module 1 Computing Fundamentals

Stczrting and Shutting Down the Computer

1-1.1.8 . . . .
Startmg a computer is simple. Just turn it on, and the operating system does all the work.

When you turn on the computer, it first performs a self-test, which was described in Lesson 4.
Next, it loads the systems software. Once the computer is up and running, you’re looking at the
desktop of the graphical user interface (GUI). The two most popular GUIs are the Macintosh OS
and Windows.

Getting to Know Your User Interface

To work with a GUI, it is important to understand the associated terminology. Some of the
more popular components are as follows:

B Desktop: The first screen you see when the operating system is up and fully running. It is
called the desktop because the icons symbolize real objects on a real desktop.

B Icons: Small pictures that represent a folder, file, command, or some other computer func-
tion. You open the file or folder or execute the associated command by clicking or double-
clicking an icon.

B Pointer: An on-screen symbol that shows the current position of the mouse. It usually
appears as an arrow or an [-beam pointer.

B Pointing device: A device, such as a mouse or trackball, that allows the user to select
objects, such as icons or text.

B  Menu: A text interface that includes drop-down options; the user clicks on one of the
choices to execute a command.

B Scroll bar: A horizontal or vertical bar that allows the user to control which part of a list or
document is currently in the window’s frame. The scroll bar makes it easy to move to any
part of a file.

B  Window: Rectangular area of the screen; used to

display a program, data, or other information. m

Windows can be resized and moved around Windows is the name of the

the screen. operating system for the PC. A
window is an object within both
Despite the convenience of these GUI features, it is the Macintosh and Windows

still necessary to use a keyboard for many programs. operating systems.

For instance, trying to enter a document in a word
b
processor with a mouse would be impossible.

Using the Desktop

The desktop contains windows and icons. The desktop is a graphical representation of how
someone works at a desk. Working at your desk, you may look at and read documents or files,
move the documents around, put them in folders, and store and retrieve them from a file drawer.
The computer desktop works in a similar way. You have documents that you can read. You can
store those documents in folders and retrieve those documents from folders. These documents
and folders are represented by icons. These activities may seem very basic, but they are an essen-
tial part of any job. They help you stay organized.
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Shutting Down the System

It is important to shut down your computer cor-

rectly to prevent damage to the components, software, m

and data. The operating system may run a cleanup pro- e T O SomiEuier 6/iom o

gram when you shut down the computer, and it checks e
to make sure all applications and data files are closed your computer is configured to
before shutting down. If you turn off the computer or show the Windows XP Welcome
unplug it without going through the shutdown process, screen for users to log on. If

you will see a warning screen when you start the com- YOI SRipUEes (8 Mol S2i Up fol
multiple users to log on by click-

puter again. This message will remind you that the sys- ing their account name, you may
tem did not shut down properly the last time, and the instead see the option Shut
operating system will check the disk drives for errors. To Down on the Start menu.

avoid this, shut down the computer properly every time.

In Windows XP, you shut down the computer by clicking the Start button and then selecting
Turn Off Computer or Shut Down at the bottom of the Start menu. When the Turn off computer
dialog box displays, you will see the options Stand By, Turn Off, and Restart (Figure 1-1). Select
Turn Off.

FIGURE 1-1
The Windows Turn off computer dialog box

Turn off computer

Stand By

Workmg with Storage Media

S Early personal computers used floppy disks to store data and programs. The first floppy

disks for microcomputers were 5%-inch magnetic disks in plastic sleeves that really were
“floppy.” You could bend a disk easily—and possibly destroy what was on the disk. These disks
were replaced by 3/-inch disks in a rigid plastic case that are more durable and take up less space
to store, but as you learned in Lesson 2, they only store about 1.44MB of data. Other storage
media, such as Zip drives and CD-R disks, are portable like floppy disks, but they can store
much more data. And hard disk drives, although not portable, have a storage capacity that
almost seems limitless.

In the days of true floppy disks, if you wanted to save your work on a disk, you had to for-
mat the disk first. Now most storage media, including 3’-inch floppy disks, CD-R and DVD
disks, and flash memory, come preformatted and ready to use. If you ever need to format a
floppy disk, it is a simple process that you can perform using My Computer.
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S TEP-BY-STEP 1.1

. On the desktop, double-click the My Computer icon to open the window. (If there is no gj
My Computer icon on the desktop, click the Start button and then click My Computer in the
Start menu.)

2. Click the 3% Floppy disk (A:) icon to select it and then move the mouse pointer over the selected
icon and right-click to display the shortcut menu.

3. Select Format to display the Format dialog box. Most of the options shown in the dialog box can be
left as they are set. You can enter a label or name for the disk in the Volume label text box.

4. To begin formatting the disk, click Start.

5. You will see a warning box that tells you all data on Computer Con E

the floppy disk will be deleted. Click OK. The line at The option Create an MS-DOS

. - startup disk in the Format dia-
the bottom of the dialog box indicates the format sl e G e

progress. copy system files so the com-
puter can be booted from the
6. Click Close to close the Format Results dialog floppy disk.

box. Leave the My Computer window open for
the next Step-by-Step.

When a floppy disk is formatted, it is organized into m—

tracks and sectors. A sector is pie shaped and can hold o iave e ey el it &

512 bytes of data. A track is a narrow band that forms lot of data you would like to dis-
a full circle on the surface of the disk. Each track is card, you can just reformat the
numbered and labeled in the formatting process, and disk using the Quick Format

the file allocation table (FAT) on the disk logs the infor- option in the Format Dialog box.

Keep in mind that when you for-
mat a disk, any data contained
Remember that it is important to handle all storage on that disk is erased.

media with care. Some precautions to take with any
disk include keeping them away from magnetic fields
generated by monitors, calculators, telephones, and other electronic devices. Never drink, eat, or
smoke near a disk, and do not expose disks to extreme temperatures (never leave a disk in your
car for any length of time to avoid this). Don’t touch the flexible part of a floppy disk or the sur-
face of a CD or DVD disk, and never set anything on top of a disk if you still want to use the data
on it. Take care of your storage media and you will protect the data stored on them.

mation about each track.

Opening and Closing a Window

1:3.2.2 . - . : : : o
Almost everything you do within a graphical user interface requires working with windows.

Windows contain the programs you run and the data with which you are working. Opening a
window is as easy as double-clicking an icon. This executes a command and opens a window on
the desktop. It is easy to open and close windows and to move windows from one place to
another on the screen. One of the windows you may want to view often is the Recycle Bin.
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To view the Recycle Bin, point to the Recycle Bin icon on the desktop and double-click the
mouse. This executes the program and opens a new window. If there is anything in the Recycle
Bin, it is represented by either icons or by text (see Figure 1-2). You will see that the icons in the
Recycle Bin represent files and folders that have been recently deleted. You can retrieve the data
in any file in the Recycle Bin. Point to the file’s icon, right-click, and select Restore from the

shortcut menu.

FIGURE 1-2
The Recycle Bin window

Lesson 1 Essential Computer Skills

Recycle Bin Tasks
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Exploring a Window

A window contains many parts (see Figure 1-3). There is a #itle bar at the top of the window,
and then a menu bar. Most windows also include a toolbar below the menu bar. There may be a
ruler below the toolbar and another ruler along the right side of the document window. For
longer documents, you will see a scroll bar at the right of the document window that lets you
quickly scroll through the file. To help you manage the desktop effectively, you have the

following options you can use to manipulate windows:
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FIGURE 1-3
The parts of a window
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B Maximize: Move the mouse pointer over the Maximize button and click the button
(Figure 1-4). The window fills the full screen. Notice that the graphic on the Maximize
button changes and it now becomes the Restore Down button.

FIGURE 1-4
Maximize button/Restore button

Maximize Restore Down

B Restore Down: Move the mouse pointer over the Restore Down button and click the but-
ton. The window returns to its previous size.

B Minimize: Move the mouse pointer over the Minimize button and click the button. The
window disappears from the screen and is displayed as a button on the taskbar, the hori-
zontal bar at the bottom of monitor screen that appears to the right of the Start button. The
taskbar is shown with the Recycle Bin window minimized on it in Figure 1-5.

FIGURE 1-5
Recycle Bin displayed as button on the taskbar

B  Move: If you don’t like where the window is located on the screen, just move it. Move the
mouse pointer over the title bar. Hold down the button and drag the window to its new
location. A maximized window cannot be moved.

B Resize: You can easily change the size of a window. Move the mouse pointer over an edge
of the window; hold down the button and drag to make the window smaller or larger. You
can change both the width and height of a window at the same time by dragging a corner. A
maximized window connot be resized.



M1L5 C5338 33912_M1L5 C5338 33912 27/04/2010 09:07 Page 79 4@i

Lesson 1 Essential Computer Skills

Closing a Window

To close the Recycle Bin window, click File to drop down the File menu and then click Close,
or click the red Close button in the upper-right corner. You can close any window using either of
these methods.

If you have used the Minimize button to reduce an application to a button on the taskbar and
you want to close the application window, you have two choices. You can click the button to
open the window and then click the Close button, or you can move the mouse pointer over the
button, right-click, and then choose Close from the shortcut menu.

Working with Files and Folders

1-1.1.8

When you start using a computer you will quickly accumulate a large number of files.
These files can easily become unmanageable. One of the best ways to organize your files is to do
what you would do with paper files—create folders for files relating to the same subject or pro-
ject. Folders are represented by icons that look like a traditional manila folder. You can even cre-
ate and move a folder inside another folder on the Windows desktop.

S TEP-BY-STEP 1.2
1. Click the Start button. @
Click My Documents in the Start menu.
In the left panel of the window, in the box titled File and Folder tasks, click Make a new folder.
The new folder appears, displaying a temporary name, New Folder.

Press Enter.

o o W N

In the left panel of the window, in the box titled File and Folder tasks, click Rename this folder. Type
a name for the new folder, such as Assignments. (Your instructor may tell you to give the folder a
different name.)

7. Press Enter.

8. Click the red Close button in the upper right of the window to close My Documents. @

To delete a folder in the My Documents window,
click the folder icon to select it, and then, in the left m
panel of the window, in the File and Folder tasks box, _
click Delete this folder. Or you can move the mouse L 16 Y DesUmEnis wies:,

. . . you can also open the File menu
pointer over the selected folder and then right-click. and choose options that include
Select Delete from the shortcut menu. In response to the New (to make a new folder),
Confirm Folder Delete dialog box, click Yes. Or click Delete, and Rename.
the folder, hold down the mouse button, and drag the
folder to the Recycle Bin.
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Managing Files

You can move a file or copy a file from one folder to another or from one disk to another.
You cannot, however, have more than one file in a folder with the same name. You can also
move, copy, and delete entire folders.

Moving a File

When you move a file, it is copied to a new location. The version in the original location is
erased. You will find this feature very useful if you want to organize or reorganize files by mov-
ing them into folders.

S TEP-BY-STEP 1.3
1. Click the Start button.

2. Point to All Programs on the Start menu, and then point to Accessories to see a
list of programs.

3. Click Windows Explorer.

4. You will see a list of folders on the left and icons representing folders in the window on the right.
Click either the folder name in the list or the folder icon to view the files in the folder.

5. Move the mouse pointer over the icon for the file you want to move and right-click to display the short-
cut menu (Figure 1-6). Click Cut.

Moving a file
% Reports E @ E\
File Edit ‘View Favorites Tools  Help ;'?
O Back ~ Tr p. ) Search Folders Elv
Folders Ll @ Commissioner's Report,dac @ September Report doc
@ Deskiop Microsoft Word Document Microsaft Word Document
= '_\ My Documents RS FaliE
) My eBooks
_), My Music :_ih
) My Pictures ~ Open
5 My videos Edit
) Reports Hew

) Snaglt Catalog Print
# ' My Computer
£ & My Network Places
# Recycle Bin

. Convert to Adobe FDF
=5 Conwert to Adobe PDF and EMail
% Combineg in Adobe Acrabat...

# [ My Stuff
Cpen Wwith r
Scan with Norton Ankivinus
S winZip 3
Send To 3

Copy

Create Shorteut
Delste
Rename

Properties

6. Locate the destination folder in the list on the left. Move the mouse pointer over the selected folder
and right-click to display the shortcut menu. Click Paste to move your file into the destination folder.
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You can also click and drag the file from one location to another.
Copying a File

When you copy a file, you create an exact duplicate of your original file. For example, you
may want to transfer a copy from your hard disk drive at home to a floppy so you can transport
it to a different computer. Or you may want to share a copy of a file with a friend. With one
exception, you use the same basic procedure to copy a file as you do to move a file.

S TEP-BY-STEP 1.4

1. In the Windows Explorer window, you will see a list of folders on the left and icons representing fold-
ers in the window on the right. Click either the folder name in the list or the folder icon to view the
files in the folder.

2. Move the mouse pointer over the icon for the file you want to copy and right-click to display the short-
cut menu (Figure 1-7). Click Copy.

FIGURE 1-7
Copying a file
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3. Locate the destination folder in the list on the left. Move the mouse pointer over the selected folder
and right-click to display the shortcut menu. Click Paste to copy your file into the destination folder.

Deleting a File

To delete a file in Windows Explorer, open the folder where the file is located to display the
file icons, select the file, right-click to display the shortcut menu, and select Delete. When you
delete a file, it is removed from the list of available files and it is sent to the Recycle Bin.
Remember, if you discover you have deleted the wrong file or need to retrieve a deleted file, it is
easy to recover the file as long as you have not “emptied” the bin. Simply open the Recycle Bin,
select the file you want to recover, right-click, and select Restore.
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Selecting Files

You’ve already learned how to copy and/or delete a single file. But what if you have a group
of files you would like to delete? It could be a time-consuming chore if you had to do these one
by one. Fortunately, you can easily select a group of files. The files can be next to each other or

they can be separated by other files.

In the Windows Explorer window, to select a group of adjacent files, click the first file to
select it. Then hold down the Shift key and select the last file in the list. The selected files will be

highlighted, as shown in Figure 1-8.

FIGURE 1-8
Adjacent selected files
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Ethics in Technology

WHAT ARE COMPUTER ETHICS?

Webster’s Online Dictionary?! offers the following definition of ethics:

1. Motivation based on ideas of right and wrong.

2. The philosophical study of moral values and rules.

Ethical judgments are no different in the area of computing than they are in any
other field. The use of computers can raise many issues of privacy, copyright, theft, and
power, to name just a few. Computer users may be motivated based on ethical or moral
judgments, or they may skirt or disregard “correct” behavior. In 1990 the Institute of
Electrical and Electronics Engineers created a code of ethics, which you can view at
www.ieee.org and by selecting About IEEE and then clicking Code of Ethics in the sub-
menu. Many businesses and organizations have adopted this code as ethical guide-

lines to govern computer use. Remember that this is just a code—not a law. People
choose to follow it voluntarily.

1 Webster’s Online Dictionary: www.websters-online-dictionary.org/definition/english/et/ethics.html
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To select a group of nonadjacent files, select the first file, hold down the Control key, and
click the remaining filenames you want to select. All the selected files, even though they are sep-
arated in the list, will be highlighted, as shown in Figure 1-9.

FIGURE 1-9

Nonadjacent selected files
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After you select the files, move the mouse pointer over any of the selected filenames, right-
click to display the context menu, and then choose Delete or Copy.

Starting and Exiting a Program

:::1;:;:2 The Recycle Bin is a utility program, so when you opened the Recycle Bin window, you
actually started a program. Let’s look at how to open a program that is not represented by an
icon on the desktop, and that is what most people mean when they talk about computer soft-
ware—an application program. We will start an application program called WordPad.

S TEP-BY-STEP 1.5

1. Click the Start button.

", start
2. Point to All Programs, then Accessoties, and then click WordPad.
3. Key a sentence or two about your favorite hobby.

4. On the File menu, click Save.

11
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STEP-BY-STEP 1.5 Continued

5. The Save As dialog box will open because the file has never been saved before (Figure 1-10). Click
the Save in drop-down arrow and click the My Documents folder if it is not already showing in the text
box. You will see the contents of the My Documents folder listed in the window.

FIGURE 1-10
Save As dialog box
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6. Double-lick the Assignments folder; this opens the folder so you can store your data within the folder.
7. In the File name text box, key Hobby.

8. In the Save as type text box, click the drop-down arrow and select Rich Text Format (RTF) if it is not
already in the text box.

9. Click Save to save your file and close the Windows Explorer window.

Switching Between Windows

Another advantage of working with a GUI is that you can have many windows open at one
time. For instance, suppose you want to open a graphics program and a word-processing pro-
gram and switch back and forth between the two. This is very easy to do.

12
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S TEP-BY-STEP 1.6

1. Click the Start button.

2. Point to All Programs, then Accessories, and then click Paint. The Paint program
opens in its maximized state. Click the Restore Down button. You now have two programs open on
the desktop—WordPad and Paint.

3. To move the window you want to work with to the front, move the mouse pointer over its taskbar but-
ton and click the button. Figure 1-11 shows the open WordPad window in the same screen as the
open Paint window.

FIGURE 1-11
Two open windows
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This example illustrates only two open programs. However, you can have as many open pro-
grams as the memory in your computer will support. You can also have more than one instance
of the same program open; that is, you can have two or more WordPad document windows
open, and so forth.

When you have several windows open at the same time, only one window is active. The title
in the active window’s title bar will appear in dark or bright lettering; the other windows will
have shaded titles in their title bars.

13
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Exiting a Program

Exit a program by closing the program window. Click the Close button in the upper-right
corner of the window, or select Close from the program menu. You can access the program menu
by clicking the program icon at the far left of the title bar. You can also select the Exit command
from the File menu to exit a program. Be sure to save any open documents first; most programs
will display a message box warning you to save open documents before exiting the program if

you have not done so (Figure 1-12).

FIGURE 1-12

Save changes message box

WordPad
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14

our computer may have many software programs
already installed, but at some point you will want to
install a new applications program, or perhaps an
updated version of a program you already have.
Installing new software is a simple procedure that starts
by inserting the disk (usually a CD-ROM, but some
programs still come on floppy disks) into the appropriate
disk drive. You also can download a program from a
Web site, and the same basic instructions apply for
installing downloaded software.

Computer Con 9

Freeware is software that is dis-
tributed to users, usually
through a Web site, at no cost.
The author of the program still
owns the copyright for the soft-
ware, so if you download a free-
ware program, you may only use
it for your personal use. You
cannot legally distribute it to
anyone else without the author’s
permission.

S TEP-BY-STEP 1.7

1. Close the WordPad and Paint programs if you have not already done so.

2. Insert the new software disk in the appropriate disk drive.

3. InaCD drive, inserting the disk may automatically open a window showing the files on the disk. If the
program is on a floppy disk, open Windows Explorer and click 3% inch Floppy (A:) (or a similar

designation for the floppy disk drive) to list the files on the disk.

4. Find the file called Setup or Install or a file with a similar name. Double-click the filename to start it.

5. You will see a screen telling you the Installation wizard is preparing to install the new software. You
will probably also have to click a button that indicates you agree to the terms of use for the software
program you are installing. You can scroll through the terms in a text box and then click the agreement

button to continue.
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STEP-BY-STEP 1.7 Continued

6. Follow the steps shown in the Installation wizard message boxes (such as the one in Figure 1-13) to
completely install the program. You may be asked what elements of the program you want to install,
where you want to install it, and other options. It is usually a good idea to accept the options the
Installation wizard suggests for these decisions.

FIGURE 1-13
A software Installation wizard message box
1 Microsoft Office OneNote 2003 Setup . o
Microsoft Office OneNote 2003 Trial En
Type of Installation
Recommended Install Description
(® Typical Install Install Microsoft Office OneMote with only
the most commonly used components.
or choose another type Additional features may be installed on first
use, or added later through Add/Remove
() Complete Install Programs in the Control Panel.
() Minimal Install
() Custom Install
Install to: IC:\Program Files\Microsoft Office), Browse...
’ < Back ] [_ MNext = ] [ Cancel ]

7. When the installation is complete, the Installation wizard may indicate that the computer needs to
reboot before the program will be available. If you see this message, be sure all other programs are
closed before clicking OK or Finish to reboot the system.

8. After the computer restarts, you can double-click the shortcut icon for the new program on the
desktop (or find the name of the program in the All Programs list and click it) to start the program.

9. You may be asked to register the program. If you have

an Internet connection, you can register the program m

immediately; if not, click the Register Later option to Some programs require a key

begin using the program. It is a good idea to register a number or code that must be
entered to install or register

new software program so that you can take advantage ) ,

. them. You can usually find this
of technical support and upgrades offered by the soft- code on the program disk or on
ware company. the software’s packaging.

Software Upgrades

Software is always being revised and changed. We have already examined the many versions
of operating systems that have been developed in the past few years. In Lesson 4 you learned
about Windows 95, Windows 98, Windows 2000, and Windows XP. Sometimes you can upgrade
an existing program by installing some additional code, but some upgrades are so extensive they
require you to install completely new programs.

15
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Applications software is upgraded also, and like systems software upgrades, the new versions
include new features. Software is also upgraded to fix problems (or bugs) that have been reported
and to make the software more compatible with other products, such as newer hardware or a
new operating system.

It is often beneficial to upgrade software, especially when the new program offers convenient
and up-to-the-minute features. But there are also negative aspects of upgrading. For example,
you may run into compatibility problems if you try to install newer software on older hardware,
or the new program may create conflicts with other software installed on your computer.
Sometimes if you upgrade to a new version too soon, you risk problems with software that was
released too quickly and may have bugs that were not all worked out yet. A manufacturer’s Web
site may offer information about a particular software upgrade, and many independent Web sites
and industry news regularly report on the pros and cons of specific upgrades.

Staying Informed About Upgrades

If you register software with the manufacturer, you may be notified of upgrades to the pro-
gram by e-mail. You can also check the manufacturer’s Web site for information about the most
recent versions of the software. Sometimes minor “patches” and updated material are offered to
registered users at no cost. Even a completely new version of a software program may be avail-
able to a registered user at a reduced cost.

SUMMARY

In this lesson, you learned:

B When you turn on your computer, the operating system performs all the necessary startup
tasks automatically.

B Some of the components of a GUI are the desktop, icons, pointer, pointing device, menus,
scroll bar, and windows.

B The desktop is a representation of how people work at a desk and contains windows
and icons.

m  Shut down the computer using the operating system’s Shut Down or Turn Off Computer
command to prevent damage to components, software, and data.

B Formatting is the process of preparing a disk so it can be used to write data to and read
data from the disk. Most disk media today are preformatted, but you can reformat a disk
to erase all the information on it.

Click or double-click an icon to open a window.
You can move a window, resize it, maximize it, minimize it, or restore it to its original size.
Close a window by clicking the Close button at the upper-right corner of the screen.

Use folders to organize your files.

Delete folders and files by right-clicking on the folder or filename and using the shortcut
menu’s Delete command or by dragging it to the Recycle Bin.

B When you move a file, it is moved to a new location.
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When you copy a file, you create a duplicate of your original file in another location.
You can select, move, copy, or delete a group of adjacent or nonadjacent files and folders.

You can start a software program by clicking on its name in the All Programs list on the
Start menu.

B You can have several windows and/or programs open at one time and can switch between
open windows.

m The title bar of the active window in your screen has a title in dark or bright lettering; other
open windows in the same screen will have shaded titles.

B To install new software, you start the Install or Setup file and follow the instructions in the
Installation wizard.

B Itis a good idea to register new software to take advantage of the technical support and
upgrades offered by the software company.

B Software upgrades can offer new features and fix bugs, but some upgrades may also cause
compatibility problems or might be released before they are problem-free.

VOCABULARYRepiew

Define the following terms:

Desktop Menu bar Taskbar
Folder Minimize Title bar
Icons Pointing device Toolbar
Maximize Restore Window
Menu Scroll bar

REVlEWQuestions

MULTIPLE CHOICE

Circle the best response for each of the following statements.

1. The __ s the first screen you see after the operating system is loaded.
A. WordPad
B. menu options
C. desktop
D. format

2. To keep your files organized, you create
A. menus
B. icons
C. folders
D. desktops

17
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3. Graphical representations of files and programs are called
A. icons
B. menus
C. pictures
D. scroll bars

4. To move a window, move the mouse pointer overthe __ | press the left mouse but-
ton, and drag.
A. scroll bar
B. icon
C. desktop
D. title bar

5. When you create a duplicate of a file, youare __ the file.
A. moving
B. copying
C. deleting
D. executing

6. A small picture representing a file or folder is called a(n)
A. menu
B. taskbar
C. icon
D. detail

7. The Recycle Bin allows you to retrieve a deleted file by usingthe — command.
A. Undelete
B. Undo
C. Retrieve
D. Restore

8. A new version of a software program is called a(n)
A. upgrade
B. application

C. bug
D. wizard

9. FindanInstallor __ program file to install new software.
A. Configure
B. Setup
C. Menu
D. Format

10. A new software program can be installed from any of the following sources except a(n)

A. downloaded file
B. output device
C. CD disk

D. floppy disk

18
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TRUE/FALSE
Circle T if the statement is true or F if the statement is false.

T F 1. You can only copy files, not move them.

T F 2. You can only open one window at a time.

T F 3. A pointer is usually seen as an I-beam or arrow on the screen.

T F 4. Formatting a disk erases any data it contained.

T F 5. To select a group of adjacent files, select the first file, then hold down the Shift key
and select the last file in the group.

T F 6. The toolbar provides drop-down options from which to choose commands.

T F 7. A window can be resized or minimized to a button on the taskbar.

T F 8. To close a window, you click its Quit button.

T F 9. You can close a window that is minimized simply by double-clicking its button on the
taskbar.

T F 10. The Program wizard guides you through the process of installing new software.

PROJECTS

PROJECT 1-1

Examine the desktop of the computer you are using and write a report on the various ele-
ments on the desktop. Describe the system you are using and then describe what you think is the
best operating system—a visual system with icons or a text-based system.

PROJECT 1-2

If your computer has the Windows XP tour installed (look in the Accessories list in All
Programs for a program called Tour Windows XP), click on the program name to open it. Your
instructor will tell you if your computer can run the animated tour with sound, or if you should
choose the non-animated tour with text and images. Click Next to start the tour. Choose
Windows XP Basics. When you have finished the tour, write a short report about what
you learned.

PROJECT 1-3

Use an Internet search engine such as Google or AltaVista to search for a freeware program
that offers a way to keep track of your assignments or work projects. Use a keyword such as free-
ware assignment calendar. With your instructor’s permission, download the program (following
the instructions on the Web site) and then install it by starting the Install or Setup program.

19
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@ TEAMWORK PROJECT

You now have some information and knowledge about using a computer. Team up with a
friend or coworker and create an outline for a training program. Include all the main elements
that you think are necessary for someone to be an effective computer user.

CRITICALThinking

ACTIVITY 1-1

In a work environment, you often find yourself working with other people as a group. You
may be one of a group of food service employees working together in a restaurant or you may
work with a group of people who are responsible for restocking shelves in a retail store. Now
think about putting groups of files into folders. Are there any similarities between this and peo-
ple working together as groups? Any differences? Make a table listing similarities and differences
between files in folders and people in work groups.
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THE WINDOWS

OPERATING SY

OBJECTIVES

Upon completion of this lesson, you should be able to:
B Describe the general features of Windows XPR
B Use a mouse to move around the desktop.

B |dentify the parts of the window and what each
one does.

Work with menus and menu elements.
Work with dialog boxes.
Manipulate multiple windows.

Access the Windows Help feature.

Shut down Windows.

Estimated Time: 1.5 hours

Windows is a simple, familiar word, which does not sound
very high tech. Yet Windows is an accurate name for a rich, power-
ful, high-tech software program. The Windows operating system is
a visual or picture-oriented environment that provides an easy way
for users to communicate or interact with the computer using
graphic icons and buttons. Remember, Windows offers a graphical
user interface, as opposed to the text-based DOS, and Windows’
visual environment is the key to understanding and to using this
impressive program.

But a graphical user interface does more than make Windows
easy to use. One key benefit of a GUI is that it provides a consistent
way to work within each program, a consistent way to work with
other programs, and a simple and consistent way to switch between
programs.

VOCABULARY

Active window
Address Bar
Clicking
Command buttons
Commands

Default

Dialog box
Double-click
Dragging

Linking

Log off

Log on

Mouse buttons
Option buttons
Radio buttons
Right-click

Select (highlight)
Shortcut keys
Shortcut menu
Shortcut menu button
Standard desktop
Standard toolbar
Start button

Status bar
Submenu

21
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The Windows World

The Windows environment provides you with an electronic version of your desktop, com-
plete with electronic tools and supplies, all accessible at your fingertips. Its parallels with the
physical desktop are not accidental; Windows is designed to be your workplace. Here you will
work with your mouse by moving and clicking. You can check your clock (which automatically
resets for daylight savings time changes), use your calculator, grab your files and folders, dial
your phone, surf the Internet, and open your briefcase. You can instantly see a complete listing of
all your tools and supplies, a complete log of all your files and folders—a complete inventory of
everything on your computer. And don’t forget that wastebasket, which Windows calls a Recycle
Bin. You can even decorate your Windows desktop, as you will see later.

You can’t appreciate the full potential of Windows until you understand its powerful capa-
bilities, such as file linking and automatic file updating. This powerful yet friendly software is an
operating system; that means it manages everything—both the hardware and the software that
operate your entire computer system. With Windows, you shift to each new task and open or
close programs as effortlessly and quickly as when you use your remote control to switch
between TV channels. While one window remains open and active on the desktop, others remain
open but inactive—either on the desktop or as buttons on the taskbar.

You learned in Lesson 4 that this capability of running several tasks, or programs, at the
same time is called multitasking. Multitasking allows you to process data in one program while
you are working in another. For instance, while you are working on a spreadsheet in one win-
dow, you might be printing a word-processing document in another window.

And with Windows’ linking features, you can easily transfer data among programs and update
the data automatically. For example, if you need to prepare a report every month that includes a
financial statement in a spreadsheet, you can put the spreadsheet into a word-processing document
and /ink it to the spreadsheet program so that updates made to the spreadsheet will automatically
appear in the word-processing report.

@Windows Updates

1-2.1.3

22

Whether you are new to Windows software or not, adapting to new software—even a new
version of familiar software—can be taxing. Learning new tools and unfamiliar features can be
time-consuming and may require training. But Windows simplifies the process considerably.
Consequently, if you’ve used an older version of Windows, you’ll make the transition easily to
Windows XP Professional. As you make the transition, you’ll see that Windows XP provides:

m Easier, faster, and more powerful ways to work with application programs, as well as spe-
cial hardware settings and increased speed for your network connections.

B Greater reliability and built-in support for hardware and software improvements, such as
being able to use up to four monitors at a time.

Enhanced versions of desktop tools, the taskbar, and the Start menu.

Upgraded support for multimedia that allows you to receive high-quality movies and audio
directly on your desktop.
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B A single, easy way to have automated access to and delivery of information—whether it is
located on your computer, the local area network, or the Internet.

B A mechanism that schedules delivery of information from the Internet that you want to
monitor, without requiring that you physically visit the site or even connect to the Internet.

B Advanced capabilities for Internet Explorer and support for all Internet standards.

Starting Windows

Windows XP automatically starts when you turn on your computer. If you are the only per-
son using your computer, Windows XP displays your desktop, ready for you to begin your work.
However, Windows may ask you to click a user name before it will give you access to the com-
puter. This is because Windows XP lets many different users create their own accounts. Each
account contains all the settings the user likes, such as screen colors, placement of items on the
desktop, and other program options. In order to do this, Windows XP needs to know who is
going to use the computer. If your computer uses this feature, each time you start the computer,
a Welcome screen appears, as shown in Figure 2-1, with each user’s account name and an associ-
ated icon. You must log on, or tell the computer who you are, by clicking one of the user names
and, if prompted, entering a password. If you do not follow the correct logon procedure for the
computer, you will not be able to access the system. Windows loads all your preferred settings
and opens to the Windows standard desktop, as shown in Figure 2-2.

—_— =

-3.2.
-3.2.
-3.1.

g b w

FIGURE 21
Windows XP may ask users to log on

/ User names
¥y

WIHdOW

To begin, click your user name

[B) Turn off computer

The Windows XP operating system is made up of many specialized computer files that create the
Windows environment, including the desktop. Like any computer files, operating system files can
become damaged by power surges, viruses, or out-of-date coding. If fundamental operating systems
are corrupted, the operating system may need to be reinstalled or updated. A system that frequently
locks up and requires rebooting may be a warning sign of unstable operating system files. It’s impor-
tant to reinstall or update the operating system when needed to protect the computer and its data files.
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S TEP-BY-STEP 2.1

1. Turn on your computer system.

2. Windows will start automatically.
a. If prompted, click one of the user names or enter the user name you have been assigned. (You
may need to ask your instructor or system administrator for assistance with which user name and
password to use.)

b. If prompted, key your password. As you key your pass- _
’ AU . Computer Con
word, the password box will fill with black circles— p : : . E
one for each character in your password. Your A computer's operating system
e i checks a password by compar-
password won't display for security reasons, so key ing the characters (usually a
your password carefully. If you can’t remember your group of letters or numerals)
password and you had a password clue entered to {r?ute”ter to ta list 'tthSt?rej
: . at associates authorize
help you remembgr, click the blue box with the gues— users with their passwords. If
tion mark to the right of the password box to display the password you enter
a memory clue to your password. matches the one in the com-
. . . puter’s list for your user name,
c. If your system is set up for multiple users, click the you can log on to Windows.
green arrow to the right of the password box or

press Enter on the keyboard or click the OK button.
Windows should then start.

3. Compare your screen with that illustrated in Figure 2-2. Your screen may differ slightly, and there may
be more icons on the desktop, but the basic elements should be the same. Spend a few minutes
looking at the layout of your screen and the position of the elements. If your screen does not display
elements similar to those shown in Figure 2-2, ask for assistance. Remain on the Windows desktop
for the next Step-by-Step.

FIGURE 2-2
Windows XP standard desktop

Iy Stuff

Desktop

Recycle
Bin Icon

An Icon

Quick
Launch
bar

Taskbar

Start but-
ton " stant BEuxazB-EBEE -6
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When you open a window, the software determines the window size and location on the
desktop. A predetermined software choice or setting is called the default. You can change many
defaults; for example, you can control the position and size of your windows by changing the
default settings. (We will examine changing settings and customizing the desktop in Lesson 8.)

Look again at Figure 2-2, which identifies the main components of the opening Windows
screen: the desktop, the taskbar, the Start button (which gives you access to the Start menu), the
Quick Launch bar, and icons you can use to work with Windows programs and features.

The Taskbar

Locate the taskbar in Figure 2-2, in its usual default location at the bottom of the screen. You
can move it to the top, left, or right side of the desktop to suit your needs. Wherever you choose
to position it, you will find the taskbar to be a very convenient helper.

You use the taskbar for two important tasks: to display the Start menu and to switch among
currently running programs that you want to keep open. Every program you keep open is repre-
sented by a button on the taskbar that offers easy access to all your running programs—just click
the button. For example, if you open Excel, the taskbar displays a button for that program. If
you then decide to run Paint, the taskbar adds a button for that program. One glance at the icons
on the taskbar buttons tells you which programs are running (active).

The Start Menu

You click the Start button on the taskbar to display the Start menu, as shown in Figure 2-3.
The Start menu contains a list of options you will use throughout this book that enables you to
complete frequently performed tasks quickly and easily. For example, you can launch programs
from the Start menu, open recently used files, change your system’s settings, find files or folders,
access Help topics, and close or shut down Windows.

FIGURE 2-3
The Start menu

___] My Documents

& My Recent Documents #
j} My Pictures

- =

_;_/ My Music

g.! My Computer

;‘l\é Printers and Faxes

@ Help and Support

All Programs D @ Do More with Gateway

‘| Undock Computer I| Log Off @| Turn Off Computer
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Look closely at the Start menu shown in Figure 2-3. Notice that the items on the menu are
placed in one of four sections. These sections are at the top, bottom, left, and right of the menu.
The login user name is displayed in large letters in the section across the top of the menu, and
options for logging off or shutting down Windows are displayed along the bottom of the menu.
A list of folders and programs is displayed on the left and right side of the separator line in the
middle portion of the start menu.

The items on the right side of the separator line are known as the pinned items list. These
items remain there and are always available for you to click to start them. You can add items to
the pinned items list. The list of programs on the left of the separator line is known as the most-
often-used-programs list. The programs displayed on the most-often-used-programs list appear
there when you use them. Clicking the All Programs item opens a list of programs currently
installed on your computer. When you click one of these programs, the program is placed in the
often-used-programs list. Windows has a default number of programs that are displayed on this
list. When that number of programs is reached, a program you have not opened recently is
replaced in the list. You can change the default number of programs displayed on the most-
often-used list.

Following is an explanation of the options commonly found on the Start menu:

B All Programs contains a complete list of the programs installed on your computer and
allows you to launch any program quickly from the desktop.

My Documents contains a list of the documents saved in this folder for quick access.

My Recent Documents contains a list of the documents that were recently opened or cre-
ated. Your computer may not show this option, but you can add it by customizing your
Start menu. Other optional entries in the Start menu include Favorites, My Network Places,
Printers and Faxes, and System Administrative Tools.

My Pictures contains a list of the digital photos, images, and graphic files saved in this folder.
My Music contains a list of music and other audio files saved in this folder.

My Computer displays the contents of your computer. You can see the hardware devices,
resources, programs, and files that are stored on your computer. My Computer also pro-
vides information about different system resources, such as the size of the hard disk and
how much space is available on it. You can also use My Computer to format disks and to
run programs.

m  Control Panel provides options for customizing the “look and feel” of your desktop. For
instance, the Control Panel option lets you change settings, such as the computer’s
date/time, desktop background, display colors, keyboard language, and mouse controls.

B The Help and Support option opens the Windows Help facility, an easy-to-use program that
provides you with information about Windows and its programs.

B The Search option is one of the most important capabilities in the Windows program. It
helps you find files and folders. This option also lets you search for Web sites you visit fre-
quently, plus it provides a quick way to find people whose names are stored in a variety of
electronic address books.

B The Run command allows you to begin a program quickly from the Start menu. You can
also use this command to find a file or program.



M1L7 C5338 33912_M1L7 C5338 33912 27/04/2010 09:15 Page 115 4@i

Lesson 2 The Windows Operating System

m The Log Off option permits you to exit the account you are using and keep the computer
on for you or another user to log on at a later time.

B The Turn Off Computer (or Shut Down) option provides options for safely shutting down
and/or restarting Windows and your computer.

The Quick Launch Bar

The Quick Launch bar on the taskbar displays icons for frequently used programs so they are
always visible on your desktop. You will see small icons that represent programs, settings, and
other features. The Quick Launch icons let you launch these features quickly—just click to open
a window or dialog box. You can find out what each icon on the Quick Launch bar will do by
resting the mouse pointer on the icon. A balloon will appear describing what the icon is.

[E}Moving Around the Desktop

1-3.24

Y ou have already used the computer’s mouse to click and open an application, and you can
see the pointer you control with the mouse move around the Windows desktop. The mouse lets
you race all over the screen—and, if you want, carry materials with you as you move.

Recall that the mouse is an input device. It allows you to find files, access tools, grab folders
you need to move, or place items on the Windows desktop. Of course, you can also use the mouse
to put those tools, files, or folders away. But that’s not all. The mouse serves a number of other
convenient uses. Your desktop is a visual work area, and the mouse is the key to that work area.

Most computers include a mouse as standard equipment. However, some systems, especially
portable laptop and notebook models, may have an integrated trackball, touchpad, or
Trackpoint on or next to the keyboard. These input devices work like a mouse, but they take less
space and don’t require a desk to move around on.

I:—C Working in a Connected
mizZs

ADMINISTRATIVE ASSISTANT

The administrative assistant is responsible for the overall functioning of an office. The
position requires the person to work with considerable initiative in the absence of the
supervisor and to exercise independent judgment within the framework of established
policies and objectives.

The computer is the main tool that the administrative assistant has to complete many
of the required tasks, using word-processing, database management, spreadsheet, and
personal information software programs daily. The administrative assistant also uses other
types of computer capabilities depending on the type of office in which he or she works.
The qualifications required to be an administrative assistant include excellent communica-
tion skills, both verbal and written; knowledge of modern office practices, systems, and
equipment; the ability to handle multiple projects simultaneously; strong math, interper-
sonal, and organizational skills; and a professional, friendly, and outgoing personality. A
college degree is usually preferred. Evidence of some training and impressive experience,
however, is sometimes acceptable.

27
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If you’re using a conventional mouse, clear an area

(at least 1 square foot) next to the keyboard on your Computer Co M

computer desktop for moving the mouse. For best per- A wireless mouse is sometimes
formance, use a mouse pad. It’s specially designed to sit called a hamster because it has
under your mouse and facilitate its movement. Hold no “tail,” or cord, to connect it to
the mouse so the cable extends outward (away from the computer. Instead, it trans-

mits information to the computer

your hand) and the body of the mouse rests under the g ;
with infrared impulses.

palm of your hand. Rest your index finger lightly on
one of the buttons.

The Mouse Pointer and Its Shapes

The arrow you see on the desktop is the mouse pointer, a graphical element you move around
the screen to select items (such as icons and menu options), issue commands, and move or manipu-
late screen elements (such as text or windows). Move the mouse and you will see the arrow move.

The pointer changes its appearance depending on the task in which Windows is engaged. Most
of the time, it looks like an arrow, but it may assume a number of other shapes. For example:

B  When you are working with text, the pointer changes to an I-beam.

B When Windows is working on an instruction and isn’t ready to accept further input from you,
the pointer changes to an hourglass (or some other icon, like a bouncing ball, if you have chosen
a different theme for Windows). This icon means “Wait. Windows is busy finishing a task.”

B  When an arrow is attached to the wait icon, it indicates that Windows is working on a task
but you can still select and move objects.

B  When the pointer turns into a circle with a slash through it—the international “no”
symbol—the message is “This action is not allowed.”

When you move the pointer over parts of a window, the different pointer shapes give you
visual clues about how you can move the mouse.

Operating the Mouse

The mouse moves the pointer around the screen, but it does much more than that. The mouse
allows you to move windows and to choose various programs by using the mouse buttons. Every
mouse has one, two, or three buttons, depending on the manufacturer. By default, the button on
the left is the primary button (the one you will use most often). It is also referred to as the
select/drag button because it is the one you use to select and move elements around the screen.
The secondary button, usually the button on the right, is called the shortcut menu button (short-
cut menus are discussed later in this lesson), and when you use it, you right-click. You’ll learn
when to right-click as you practice using Windows.

Your mouse may also have a “Fast Wheel” located between the primary and secondary but-
tons or on the side so you can operate it with your thumb. The wheel lets you move through doc-
uments quickly by allowing you to roll to scroll. If you click this wheel once, your pointer
changes to a large arrow and you can scroll extremely rapidly just by moving the mouse pointer
up or down on the screen.

If you are left-handed, Windows allows you to reverse the primary and secondary mouse but-
tons so you can use the mouse with your left hand. You’ll learn how to do this in a later lesson.
For the purpose of this book, however, we will always consider the left button to be the primary
button and the right button to be the secondary or shortcut menu button.
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You use the mouse buttons to select objects and to move objects or icons around the screen.
You select, or highlight, an item by pointing to it and pressing and then releasing the left (pri-
mary) mouse button. When you press and then release the left mouse button, the action is
referred to as clicking; some commands require you to double-click (that is, click twice quickly).
If you don’t double-click the button fast enough,
Windows interprets your action as two single clicks

rather than one double-click. (With a little experience, Computer Conc E

you’ll double-click expertly.) L G G L G el
Moving objects with the mouse is known as dragging. settings so different shapes

You drag an object by placing the mouse pointer on the appear to indicate the different

item to be moved, then pressing and holding down the pri- leslis, U sioese & desluop

b hile moving the object. When the FISTE N TeRenERs SRATIRoS

mary mouse button while moving ject. changed automatically to

pointer is at the right location, release the mouse button. match the theme.

Table 7-1 lists and explains five common techniques for

using a standard two-button mouse device.

TABLE 2-1
Operating the mouse

Drag Press and hold the mouse button and move the mouse in the desired direction,
then release.

Click Press and release the left (primary) mouse button.

Double-click | Click the left mouse button twice in rapid succession.

Right-click Press and release the right (secondary) mouse button.

Select Point to an item and click the mouse button.

Using the mouse proficiently requires a little practice—and a little patience. In a very short
time, you’ll use the mouse comfortably and smoothly.

S TEP-BY-STEP 2.2

1. Move the mouse (or other pointing device) on your desk (or mouse pad). As you move the mouse,
watch the screen to see how the pointer moves:

a. Move the pointer to the far left of your screen by sliding the mouse to the left on the desk or
mouse pad. Do not lift the mouse.

b. Move the pointer to the far right of your screen by sliding the mouse to the right.

¢. Move the pointer to the top of your screen by moving the mouse toward the top of your desk or
mouse pad.

d. Move the pointer to the bottom of your screen by moving the mouse toward the bottom of your
desk or mouse pad.

2. Display and then close the Start menu:

a. Point to the Start button in the corner of the taskbar.
b. Click the left mouse button.

¢. Point to a clear area of the desktop and click the left mouse button. The Start menu closes.

29
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STEP-BY-STEP 2.2 Continued

3. Select and rearrange an icon on the desktop:

a. Point to the Recycle Bin icon, and hold (do not click) the pointer on the icon for a few :J
seconds. Notice that a small window opens displaying a description of the icon. Click the
mouse button. Notice that when you click an icon, it changes color. The change in color
means the icon is selected.

b. Click anywhere on the desktop. As you do so, notice that Recycle Bin is deselected (that is, it
returns to its original color).

¢. Again point to the Recycle Bin icon.

d. While holding down the mouse button, drag the icon about one inch to the right and release
the mouse button. As you drag the icon, note how a “ghost image” of the icon follows the
mouse pointer to indicate where the icon will be placed when you release the mouse button.

e. Drag the Recycle Bin icon back to its original position.

4. Double-click the Recycle Bin. The Recycle Bin window opens.

2

5. Close the Recycle Bin window by clicking the Close button.
Identzfymg the Parts of a Window

? 1 3 24 In Lesson 5, you were introduced to the basic parts of the window. Let’s take a closer look

now at these tools and what they can do. Figure 2-4 identifies the parts of the window by name.

FIGURE 2-4
Parts of a window

b My Comput:

Tltle bar File  Edit  Wiew Favorites  Tools  Help ﬂ. c|ose buttOn
@ Back ~ 'J L‘z p Search :li: Folders v
Menu bar fdldress | ) My Computer ‘.‘! g Go  Morton Ankiirus B v

Files Stored on This Computer »| Standard

£

system Tasks

toolbar
@ Wiew system information ‘:"J Shared Documents
@ Add ar remaove programs L
Address Bar O Change a setting Scroll bar
Hard Disk Drives
Other Places e
- Local Disk {C:) =
‘3 My Mebwork Flaces E@
Click to (5 1y Documents
close anel |5 Shared Dacuments Devices with Removable Storage
p U} Control Panel 2 Borders
% Fi Floopw [8:3 w Zip L00 (D)
Selected petalls &

object’s detail E% I Comeuter

Systemn Folder
Status bar ‘

Jio ohijects

! CD Drive (E:)

Network Drives

Resize edge

3 My Computer
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B The title bar is at the top of the window. It displays the name of the program running in a
window—in this case, “My Computer.”

B Directly below the title bar is a menu bar, which lists available menus (the specific choices
depend on the program you are running). The menu bar in Figure 2-4 lists six choices: File,
Edit, View, Favorites, Tools, and Help.

B The Standard toolbar contains buttons that permit you to access various functions and to
issue commands. The toolbar in the My Computer window has buttons for navigating your
computer’s resources and for changing the display of the objects in the window. If the tool-
bar is not displayed, open the View menu, select Toolbars, and select Standard Buttons.

B The Address Bar displays the name of the open folder or object. It also permits you to key the
address of a Web page quickly without opening your browser. If it is not displayed, open the
View menu, select Toolbars, and select Address Bar. Not all applications have an Address Bar
option, however. Many programs indicate the name of an open file in the title bar with the
program’s name.

m In the rectangular window are icons, which you learned about in Lesson 5. In this window,
the icons represent the parts of your computer system and programs to control the system.
The icons in your window may be different from those shown in Figure 2-4. When you
select an icon, a description of it displays below and to the left of the icon.

B The Minimize, Maximize/Restore Down, and

Close buttons appear at the upper-right corner of m
the windoW on 'the same line as the title.bar. Recall When you load Windows, the

that the Minimize button reduces the window to a default settings on your computer
button on the taskbar, and the Maximize button may cause your screen to look
enlarges the window to fill the screen. Once the slightly different from the screens

window is full-screen size, the Maximize button shown in this text's figures.

changes to a Restore Down button, which enables
you to restore the window to its previous (smaller)
size. The Close button quickly closes the window.

The borders are the four lines that define the limits of the window.

The status bar provides information on the currently selected object or the task you are per-
forming. As you choose menu items, select window objects, or issue commands, the actions
are described on the status bar.

B The resize edge provides a large spot to grab when you want to resize a window without
moving the upper-left corner.

B When the window is not large enough to display everything, you will see scroll bars.
Clicking the scroll bar moves (scrolls) the contents of a window so you can view objects
that are hidden.
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Working with Menus

A menu is a list of options or choices. Every window you open in Windows XP contains a
menu bar offering menus. The My Computer window in Figure 2-5 has a menu bar with six
menus: File, Edit, View, Favorites, Tools, and Help. Each of these menus, in turn, offers a num-
ber of commands you can issue to perform a task or function.

FIGURE 2-5
Menu in the My Computer window

T My Computer |-_||E|E|
File Ed|t Wigw  Favorites  Tools  Help #
. Undo Rename ChlZ

%Barch = Folders v @

v| Go Morton Antivirus Q -

Files Stored on Thi;_ Computer 5|

D Shared Documnents
Select Al Chrl+a

Inwert Selection Hard Disk Drives

Other Places

=
@ Local Disk (C:)

% My Metwork Places

EB My Docurments

[ Shared Documents Devices with Remo_\_r_ahle Storage

@ Control Panel

L'\% 34 Floppy () q 7ip 100 (Dt}
Details

My Computer ° _ D Drive (E:)
Systern Folder o=

Network Drives

Selects all ikerns in the window,

If all these menu choices appeared on the desktop at the same time, your work area would be
too cluttered to be useful. Windows’ menus organize the choices so they are out of sight but
within reach. To find out what choices are available on a particular menu, you display the menu
by clicking it. When you click the menu name, the menu drops down, as shown in Figure 2-5.
Notice the differences among the listed options. One is highlighted, some are in black letters,
some are in a lighter color, and some are followed by three periods. All menu choices have one
letter underlined. Each visual element has a special meaning, as explained below.

Highlighting

In Figure 2-5, the Select All menu option is highlighted; that is, the words appear in white let-
ters within a dark box. Highlighting indicates that an option is currently selected.
Colors or Shading

Not all menu options are available to you all the time. The dark or black letters indicate
options that are currently available. Light or grayed letters indicate options that are not avail-
able. Look closely at the Edit menu in Figure 2-5. Which options are currently available?

Ellipses

An ellipsis is a series of three periods (...) following some commands. See the Copy To Folder
and Move To Folder commands in Figure 2-5, for example. An ellipsis tells you that if you
choose this option, a second window or dialog box will be displayed, requesting more informa-
tion from you. (You’ll learn more about dialog boxes later.)



M1L7 C5338 33912_M1L7 C5338 33912 27/04/2010 09:15 Page 121 4@i

Lesson 2 The Windows Operating System

Selection Letters

In some applications, each menu option has one underscored letter or number, indicating a key-
board command you can use as an alternative to the mouse. On the keyboard, press the underscored
letter or number to choose that command. You can press the selection letters only while the menu is
displayed, but in program windows that support selection letters, you can use keyboard commands
to display menus, too. For example, in many Microsoft software programs, the file names have an
underscored letter (see Figure 2-6). By pressing the Alt key and the underscored letter at the same
time, you can display the menu (for example, Alt + E displays the Edit menu in Figure 2-6).

FIGURE 2-6
An application window with menus that support selection letters

T§ Document1 - Microsoft Word

! File | Edit | Wiew Insert Format Tools  Table

|_1 I ¥} Unda Twping Chr+Z ﬁ| % B3
3 i 1+
¢ Final 4 d Repeat Typing  Ctrl b3 i3 -
;e & cut Ctrlx
ﬁ?" 23 Copy Chrl+C

2 1

|2 | office Clipboard...

8 Paste Chrl+y

Paste Special...
Paste as Hyperlink

Clear 3
Select Al Chrl+a
34 Eind... Chrl+F
Replace. .. Chrl+H
GoTo... Chrl+ic

Links...

Cbject

Shortcut Keys

Some menu options list shortcut keys to the right. Unlike selection letters, shortcut keys can
be used even when the menu is not displayed. Shortcut keys also offer the advantage of not hav-
ing to remove your hands from the keyboard while you are keying.

Shortcut keys generally combine the Alt, Ctrl, or
Shift key with a letter key. In this text, such combina- m—
tions are expressed as follows: Alt + X or Ctrl + O. In :

Figure 2-6, the shortcut keys for the Select All com- :)((:Lljocaenrcuassee?g'p[z:su?gf;%i)sr?—
mand are Ctrl + A. To execute this command using the cut kvéys.

shortcut keys, press the Ctrl key and hold it down
while pressing the A key. Then release both keys at the
same time.

Right-Pointing Arrow

A right-pointing arrow next to a menu option (such as next to Clear in the Edit menu in
Figure 2-6) indicates that if you point to that option, another menu will appear with more
options. This second menu is a submenu. Windows automatically opens submenus after the
pointer has been resting on an option for a short period of time. You can click the option to dis-
play the submenu immediately.

33
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Selecting an Option from a Menu

To select an option from a menu, first open the menu by clicking the menu name on the menu bar.
You’ll find that as you move the pointer down the menu, the highlight also moves. Stop the pointer on
the option you want to choose, and then click. The command you have chosen will execute.

You can also execute a command using the command’s shortcut keys, if available. After you
have become familiar with commands, you may find it easier to use shortcut keys for the com-
mands you use most often.

S TEP-BY-STEP 2.3

1. Click Start, and then click My Computer in the Start menu. @

2. Display the options in the Favorites menu:
a. Click the Favorites menu name in the menu bar.
b. Select Links or let the mouse pointer rest on the option for a few seconds.

¢. You can click on a link, but if you do not have Internet access available, you will get a message
saying the page cannot be displayed or that you do not have an Internet connection. If necessary,
click Work Offline.

d. If you do link to a Web page, click the Close button. [E]

3. If necessary, restart My Computer and then select all the icons in the My Computer window:
a. Click the title bar on the My Computer window to verify that it is selected.
b. Key the shortcut Ctrl + A. All the icons are now selected.
¢. Click somewhere in the blank (white) space in the My Computer window to deselect the icons.

4. Close the My Computer window by clicking its Close button. E]

Working with Dialog Boxes

Some menu options, such as the Run... command in the Start menu, need more information
before they can be executed. For example, before Windows can run (start) a program, it needs to
know the program name. The ellipsis (...) that follows such a command signals that need for
additional information. You provide the needed information by responding to a dialog box, such
as the one shown in Figure 2-7.
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FIGURE 2-7
Command buttons, option buttons, and text boxes in a dialog box

Page Setup
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A dialog box is itself a window and has some of the same features as a window, such as an
identifying title bar and a Close button. But dialog boxes contain a number of other elements
that help you give information to your computer. Let’s take a look at the elements you will find
most often in dialog boxes.

Buttons

There are two types of buttons: command buttons and option buttons.

B Command buttons carry out your instructions using the information selected in the dialog
box. Command buttons are always rectangular. When you press a command button, the
program accepts your instructions. If there is an ellipsis on the button (for example,
Browse...), choosing it will open another dialog box. Typical command buttons are Open,
Help, Cancel, and OK. The dialog box in Figure 2-7 contains three command buttons: OK,
Cancel, and Printer....

B Option buttons (sometimes called radio buttons) allow you to choose one option from a
group of options (see Figure 2-7). To change a selection, simply choose a different button.



M1L7 C5338 33912_M1L7 C5338 33912 27/04/2010 09:15 Page 124 4@i

Module 1 Computing Fundamentals

Boxes

There are four types of boxes: text boxes, check boxes, list boxes, and drop-down list boxes
(see Figure 2-8). A combo box combines two types of boxes.

FIGURE 2-8
A dialog box containing several kinds of boxes

Scroll box
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[ Strikeaut .
Check boxes ! AaBbYyIz List box
[ Underline
Color:
Script: Drop-down list
_ | Westem v box (closed)
Drop—down list hiz same fank wil be uzed on baoth wour
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B Text boxes: Text boxes allow you to key information in the dialog box. A text box may con-
tain a blinking insertion point to show you where to begin keying, or it may already contain

text that you can change as necessary. To change existing text, highlight it by double-clicking
it and then key the new text.

B Check boxes: Check boxes allow you to make choices from a group. However, unlike
option buttons, you can check several boxes; that is, you can select a variety of options.
Clicking with the mouse selects (v') or deselects a check box.

B List boxes: List boxes present a set of options in list format. When the list of options is too
lengthy to fit in the box, scroll bars are available to allow you to scroll through the items.

Drag the scroll box to move up or down the list. Figure 2-8 shows scroll bars on the Font
list box.

B Drop-down list boxes: Drop-down list boxes display only one option and a special arrow
symbol. Click the arrow symbol to reveal the entire list box. Figure 2-8 shows two drop-
down list boxes, with one of the lists displayed.

B Combo box: A combo box is a combination of a text box and a list box. You can select
from the list or enter your own choice by keying it in the text box part of the combo box.
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S TEP-BY-STEP 2.4

1. Open the Start menu by clicking the Start button. @

2. Move the pointer to the Run... command on the Start menu and click. The Run dia-
log box appears.

3. If the Run dialog box on your screen contains text, make sure the text is highlighted.
4. Key your first name in the text box—do not press Enter.

5. Click the OK command button. You now see a message box (another form of dialog box) similar to
the one illustrated in Figure 2-9. Windows is telling you that it cannot locate the file you asked to run.

FIGURE 2-9
Message box

‘Windows cannot find 'Mame', Make sure vou byped the name correctly, and then try
again. To search for a file, click the Start button, and then click Search,

6. Click the OK command button to cancel the message display.

7. Click the Cancel command button to close the Run... dialog box.

Navigating Through Windows

1-3.2.2

Windows’ multitasking ability allows you to perform more than one task at a time. As a
result, you may have a lot of windows open on the desktop at one time, and this can be confus-
ing. You can manage those windows and switch between them simply by rearranging the win-
dows on your desktop.

Arranging Windows on the Desktop

In Lesson 5, you learned to drag a window to a different location on the desktop. Dragging
can be very time-consuming when you have a number of open windows. A shortcut menu hidden
on the taskbar makes it easy to arrange open windows. The shortcut menu contains the options
that are most commonly performed from the current window display. While the shortcut menu is
handy, not all options are included on it. To access the shortcut menu, point to any portion of the
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taskbar that does not contain a button and right-click. The shortcut menu in Figure 2-10 dis-
plays, allowing you to instruct Windows to organize the open windows on your desktop. You
can choose one of three different arrangements: Cascade, Tile Horizontally, or Tile Vertically.

FIGURE 2-10
Shortcut menu

Toolbars »

Cascade Windows

Tile Windows Horizonkally
Tile Windows Yertically
Shows the Deskbop

Task Manager

Lock the Taskbar
Froperties

B The Cascade Windows option cascades the open windows into a stack with title bars show-
ing; the active window is always in front of the stack, on the top layer.

m The Tile Windows Horizontally option tiles the open windows across the desktop from top
to bottom, without overlapping any portion of any window.

B The Tile Windows Vertically option divides the desktop evenly among the open windows
and aligns the windows across the screen, left to right, without overlapping any window.

The shortcut menu also contains a Show the Desktop command, which reduces all windows
to buttons on the taskbar. You can cancel any option you select by using the Undo command. For
example, the shortcut menu would list an Undo Cascade option once you selected the Cascade
Windows option. Selecting this option restores the display to its previous arrangement.

At times, you may need to move a window to uncover another window or an object on the
desktop. The quickest way is to drag the window by its title bar. If the window is maximized, you
must first restore it to its previous size before you move it.

If you want greater control over the position and size of a window, resize it by dragging one
of the three types of window borders (horizontal, vertical, or corner) in the direction you prefer.

Switching Between Windows

When multiple windows are open on your desktop, the one you are working with is called the
active window. Remember that the active window is easy to recognize because its title bar is a dif-
ferent color or intensity. You can make any open window the active window in one of two ways:

m If any portion of the window you want to work with is visible, click it. It will come to the
front and become the active window.

B At any time, press and hold down the Alt key; then press Tab. A small window appears in
the center of the display. The window contains icons for all items currently open, including
items minimized on the taskbar. If you hold down the Alt key and then press and release
Tab, you can cycle through all the icons. A box surrounds the item’s icon and a description
appears at the bottom of the window as it is selected. When the one you want is selected,
release the Alt key. That item comes to the front and becomes the active window. This is
called the fast Alt + Tab method for switching to a different window.
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EP-BY-STEP 2.5

h

2.

10.

11.

12,

Double-click the Recyele Bin icon to open the Recycle Bin window.

&,

Click the Start button, and then click My Computer on the Start menu to open |8 start e
the My Computer window. -

®

. Click the Start button, and then click Search on the Start menu to open the Search

Results window.

. Tile the open windows using the shortcut menu:

a. Point to a blank area in the taskbar and right-click to display the shortcut menu.

b. Select the Tile Windows Vertically option. The windows are now arranged differently, in a
tiled format.

. Right-click on the taskbar and select the Tile Windows Horizontally option from the shortcut menu.

The windows are rearranged into this tiled format.

. Right-click on the taskbar and select the Cascade Windows option from the shortcut menu. The win-

dows are rearranged into a cascade format.

. Change the active window:

a. Click the My Computer window. If it wasn't in front, it comes to the foreground and becomes the
active window.

b. Click the Search Results window to make it the active window. This window comes to the front as
the active window. (You may need to move the windows around on the desktop to see the Search
Results Window.)

. Undo the cascade format and return the windows to the Tile Windows Horizontally format:

a. Point to a blank area in the taskbar and right-click to display the shortcut menu.
b. Select the Undo Cascade option. The windows are again arranged in a horizontal tiled format.

. Right-click on the taskbar and select the Show the Desktop option on the shortcut menu to minimize

all windows to buttons on the taskbar.

Open the Search Results window using the Alt + Tab feature:
a. Press and hold down the Alt key.
b. Press and release the Tab key until the Search Results icon is outlined, and then release the Alt key.

Notice that this window is still in tile format. Display the Search Results window in the cascade format
by right-clicking on the taskbar and selecting the Cascade Windows option on the shortcut menu.

Close all open windows by clicking their Close buttons. (You may need to open the other E]
programs on the taskbar to close their windows.)
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I& The Windows Help Feature

Selecting the Help and Support option from the Start menu opens the Help and Support
Center window. The Help and Support Center offers support in four categories:

B Pick a Help topic contains general information about a topic. For example, clicking What’s
new in Windows XP displays a list of resources that you can use to learn about Windows XP
features.

B Ask for assistance provides two ways for getting outside help. The Remote Assistance
option allows you to invite someone to help you. Using an Internet connection, anyone run-
ning Windows XP can view your screen and, with your permission, work on your computer.
The Support option enables you to get help from Microsoft, from product experts, or to
discuss your questions with other Windows XP users online.

B Pick a task provides access to the latest updates for your computer’s operating system, hard-
ware, and software. You can also use this category to find Windows XP—compatible hardware
and software, restore your computer to a previous working state, or access helpful tools to
keep your computer running smoothly.

B Did you know¢ displays a tip on using Windows XP. Each time the Help and Support
Center is opened, the tip that is displayed is selected at random from a group of tips, so be
sure to read the tip each time you access the Help and Support Center.

The Help and Support Center is designed to look and work much like a Web page. It has two
sections, called panes. When you point to an underlined topic in the left pane, the pointer
changes to a hand with the index finger pointing to the topic or word. This indicates that the
topic is actually a link. When you click a link, the Help and Support entry is displayed in the right
pane. For example, if you click the Fixing a problem link in the Pick a Help topic menu, the Help
and Support entry will be displayed in the right pane.

Getting Assistance Online

The Help and Support Center’s Ask for assistance section offers an option called Remote
Assistance. Remote Assistance is a convenient way for someone you know to connect to your
computer from another computer running Windows XP, chat with you, and observe your com-
puter screen as you work. With your permission, you can receive the remote user’s keystrokes as
if he or she were keying on your keyboard. In this way, you are able to watch the remote user
demonstrate the solution to your problem.

The second option in this section allows you to get support online from a technician who can
answer your questions in e-mail or an online chat session. This option also gives you access to
newsgroups that can offer tips and guidelines about working with Windows XP.

Using the Windows XP Application Help System

Selecting the Help option and then the Help Topics menu item (or the name of the applica-
tion’s Help, usually the first option) from a Windows XP application menu displays the Help
Viewer for that program. For example, when you click Help in the Windows Paint program, and
then choose Help Topics, you see the Help Viewer window shown in Figure 2-11. In some
programs, the Help Viewer may appear in a narrow pane at the right of the document window;
it has two panes when fully opened, as shown in Figure 2-11.
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FIGURE 2-11
Windows Paint program’s Help Viewer

Contents | Index | Search | Lf[_'f
Microsoft Paint overview M.

@ Izing the Help Viewer Faint is a drawing tool you can use to
create simple or elaborate drawings.
These drawings can be either black-and-
white or colar, and can be saved as
bitmap files. ¥ou can print your drawing,
use it for your desktop background, or
paste it into another document. You can
even use Paint to view and edit scanned
photos,

ou can also use Paint to work with
pictures, such as .jpa, .qif, or .bmp files.
“You can paste a Paint picture into another
document you've created, or use it as
your desktop background.

Related Topics

The three tabs in the left pane of the Help Viewer let you locate and navigate Help topics in

different ways.

The Contents tab groups topics into general categories so you can browse the table of con-
tents for an application’s Help system to locate a topic. Each main topic has a book icon
next to it. Click an icon to display a list of topics within that main topic.

The Index tab provides an alphabetical listing of key words and terms with topics specific
to the application you are using.

The Search tab lets you search the Help topics for a term or feature. Again, the available
help topics are specific to the application you are using.

S TEP-BY-STEP 2.6

1. Click the Start button, and then select the Help and Support option on the Start _ 43 start
menu.

2. Maximize the Help and Support Center window, if necessary.

3. Click the Fixing a problem link under the Pick a Help topic menu to display the Help and
Support entry.

4. Read the choices in the listing in the left pane, and then click the Application and software problems
link to display the Help and Support entry for this topic in the right pane. Notice that as you point on
the topic, it becomes underlined, indicating that it is a link, and it is highlighted when the topic’s entry
is displayed in the right pane.
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STEP-BY-STEP 2.6 Continued

5. Read the choices for this Help and Support entry in the right pane, and then click Print
Troubleshooter to display its Help and Support entry.

6. Click the Close button to close the Help and Support window.

7. Click the Start button, select All Programs, select Accessotries, and then select
Paint from the menu. When the Windows Paint program opens, click Help on the
menu bar, then select the Help Topics option. The Paint Help Viewer opens, as
shown in Figure 2-11.

8. Click the Show button, if necessary, to display both panes of the Help window.
9. Click the Contents tab, if necessary, to bring it to the front.
10. Click the Paint book icon to display its subtopics.

11. Click the Work with Color topic and then click the Paint with a brush entry in the list of links that
drops down. The topic entry is displayed in the Help Viewer’s right pane.

12. Click the Paint book icon in the navigation pane to close the book. .
13. Close the Paint program Help system by clicking the Close button on the Help Viewer’s title bar.

14. Close Paint by clicking the Close button on the title bar.

Shuttmg Down Windows

42

Y ou shut down Windows by using the Start button. You have two choices along the bottom

of the Start menu: Log Off or Turn Off Computer (or Shut Down). Each of these choices has
options:

B Log off—Selecting this choice keeps your computer running while you log off the computer

so someone else can use it. If you select this option (and your system is set up for multiple
users), Windows will open a message box asking if you want to Switch User or Log Off, as
shown in Figure 2-12. (If your system is not set up for multiple users, the message box gives
you the choice between logging off or canceling this action.)

FIGURE 2-12
Log Off Windows message box

Log Off Windows

@ 52

Switch User Log Off
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m If you choose Switch User, the Welcome screen appears, but Windows keeps your open
programs waiting for you. When the new user logs off, Windows switches back to you
as the user and everything is just as you left it.

m If you choose Log Off, Windows saves your work and your settings and returns to the
Welcome screen for the next user. Windows does not turn the computer off when this
option is selected.

B Turn Off Computer (or Shut Down)—Selecting this choice instructs Windows to prepare to
shut down. Each time you select Turn Off Computer, a message box displays, giving you
three options:

B Stand By—Select this option if you want to save electrical energy but keep your current
programs open so you can resume where you left off.

® Turn Off—This option closes all programs (if you didn’t close them first) and shuts
down Windows. Depending on how your computer system is set up, your computer’s
and monitor’s power may also turn off. If it is not set up to do this, a message box will
appear informing you that it is safe to turn off the power to your computer.

B Restart—This option quits Windows and restarts your computer, opening Windows back up.

S TEP-BY-STEP 2.7

1. Click the Start button, and select the Turn Off Computer option (or the Shut Down @
option if applicable) from the Start menu. Shutting down the computer is good to do
each time you are finished working for the day.

2. Select the Restart option. Windows will shut down and then automatically start running again. This
is helpful if you decide you need to continue working or if your computer locks up.

3. Log on if necessary to start Windows.

4. Shut down Windows again. This time select the Turn

Off option (or the Shut Down option if applicable). The m

computer may automatically turn itself off, or you will If your Start menu choice is Shut
see a message box informing you when it is safe to Down instead of Turn Off
turn off the computer. Follow your instructor’s direc- Computer, your message box will

tions about turning off the computer. be named Shut Down Windows

and it will contain a drop-down
list of options. These options
are Log off [User Name], Shut
down, and Restart. Log off works
the same as clicking Log Off
from the Start menu. Shut Down
is comparable to Turn Off. And
Restart functions in the same
manner as Restart from the Turn
off computer message box.
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Sometimes a Windows application will stop functioning or will not respond, and you cannot
close the program or perform any other tasks in Windows, such as turning off the computer. Use
the Ctrl + Alt + Del key combination (press all three keys at the same time). The Windows Task
Manager, shown in Figure 2-13, will appear. There are three options indicated at the bottom of
the box—End Task, Switch To, and New Task. End Task will close the nonfunctioning program.
To use the Switch To option, highlight one of the programs in the Tasks column that the Status
column indicates is Running. The New Task button allows you to launch another program in a
dialog box similar to the Run dialog box. If the system has “locked up” and you cannot close any
applications, click the Shut Down button at the top of the Windows Task Manager box and you
will see options including Turn off and Restart as well as other options. Select Turn off or Restart
to safely shut down the computer when the applications are not responding at all.

FIGURE 2-13
The Windows Task Manager dialog box

£l Windows Task Manager

File Options Wiew Windows Help

"ADD“CGUUHS- |Pr0cesses || Performance || Mebworking |

Task Stakus
Adobe Acrobat Professional - [0-619-243582-1... Running
@ Paint Running
U untitled - Paink Running
@ 1st Pass Pages Running
I 15t Pass Pages Running

|

i} | >

End Task Switch To

Processes: 35 CPL Usage: 2% Commit Charge: 186M [ 1155M

SUMMARY

In this lesson, you learned:
Most Windows activity takes place on the desktop.

The Windows opening screen has the following basic components: the desktop, the taskbar,
the Quick Launch bar, the Start button, the mouse pointer, and one or more desktop icons.

B You use the taskbar to open programs and documents and to switch back and forth
between running programs.
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The Start menu options let you launch programs, open recently used files, change your sys-
tem’s settings, find files or folders, access Help topics, and close and shut down Windows.

The Quick Launch icons let you open a window or dialog box with a click.

The mouse controls an on-screen pointer. The shape of the pointer will change depending
on where you are on-screen and what you are doing.

Mouse buttons let you make selections by clicking, right-clicking, and double-clicking. The
primary button is used most frequently. The secondary button is used for shortcuts.

The mouse lets you move (drag) objects.

A menu is a list of options or choices. You make selections from a menu by pointing at and
clicking an option or using the up or down arrow keys.

On a menu, a highlighted option (white letters within a dark box) indicates that this option
is currently selected, and light or grayed letters (as opposed to black or dark) mean that an
option is not available.

A right-pointing arrow next to a menu option indicates that the option has a submenu with
more options.

A series of three periods (...), called an ellipsis, following a command tells you that if you
choose this option, a dialog box will open to request more information.

A dialog box is a window. In it you will find command buttons and option buttons.
Command buttons are rectangular and you click the button to execute a command. Option
buttons (also known as radio buttons) let you choose one option from a group of options.

A dialog box may also have check boxes, list boxes, text boxes, and drop-down list boxes,
each of which allows you to make selections or key information.

Windows’ multitasking capability means that more than one window can be open at a time.
The windows can be arranged on the desktop in a cascade, horizontally tiled, or vertically
tiled format. Click any window or use Alt + Tab to bring a desired window to the front and
make it the active window.

You can access the Windows Help feature by clicking Help and Support on the Start menu.

The Ask for assistance option in the Help and Support Center offers a variety of ways to get
help, including online help. With Remote Assistance, you can allow someone you know to
connect to your computer and demonstrate the answer to a question. The Support page also
gives you access to Windows XP newsgroups where you may be able to find an answer to
your questions.

Every Windows XP application has a Help menu that opens the application’s Help Viewer.
The left pane of the Help Viewer contains three tabs that provide different options for
searching the Help system. When you select an entry on one of the tabs, the right pane dis-
plays detailed information about the topic.

When you want to shut down Windows, you select either the Log Off or the Turn Off
Computer option (or the Shut Down option) from the Start menu.

45



M1L7 C5338 33912_M1L7 C5338 33912 27/04/2010 09:15 Page 134 4@i

46

Module 1 Computing Fundamentals

VOCABULARYR cpiew

Define the following terms:

Active window Linking Shortcut keys
Address Bar Log off Shortcut menu
Clicking Log on Shortcut menu button
Command buttons Mouse buttons Standard desktop
Commands Option buttons Standard toolbar
Default Radio buttons Start button

Dialog box Right-clicking Status bar
Double-click Select (highlight) Submenu

Dragging

REVlEWQuestions

MATCHING

Match the correct term in Column 2 to its description in Column 1.

_10.

Column 1

. Desktop component that contains buttons for open programs

. Help option that allows someone at another computer

to view your screen via the Internet

. Graphical element you move around the screen

to select, move, and manipulate screen elements

. Act of moving an object with the mouse

. Icon on the desktop that contains deleted files

. A list of options or choices

. A predetermined choice made by the software

. The window in which you are presently working

. In a dialog box, the buttons that carry out your

instructions using the information selected

In a dialog box, the buttons that represent a group
of choices from which you can select one

=

= 9 0

s

T 0

b

Column 2
dragging
active window
Recycle Bin
taskbar
menu
option buttons
default
command buttons
Remote Assistance

mouse pointer
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MULTIPLE CHOICE

Circle the best response for each of the following statements.

1. The list of choices on a Windows menu bar
A. is the same for all programs
B. will vary according to the program
C. displays as icons
D. None of the above

2. Shortcutkeys |
A. can be used even when the menu is not displayed
B. are keystrokes that must be used in place of the mouse
C. always use the Alt key
D. cannot be used unless the menu is displayed

3. When a window is not large enough to display everything,
A. you can click the Restore Down button to enlarge it
B. the status bar will indicate there is more to be displayed
C. you should drag its title bar to resize it
D. scroll bars will be displayed

4. The visual element that indicates whether a menu option is available is
A. an ellipsis
B. the color of the option
C. an underscored letter
D. highlighting

5. [If additional information is needed before a command can be executed, Windows displays a

message box
dialog box
control-menu box
prompt box

SOom»

PROJECTS

PROJECT 2-1

The local library has computers available with Windows XP Professional installed. You will
be using one of these computers but can only spend one hour on it. Develop a strategy to maxi-
mize your time. Using the information from this and previous lessons, create a priority list, rank-
ing the most important features to explore and skills to practice.
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PROJECT 2-2

1. At the Web site www.microsoft.com/education/Tutorials.aspx you can find information
about free tutorials for Microsoft software. In the dialog box on the screen, you will see
several drop-down list boxes that offer choices about age level, learning area, and product.

2. Select Windows XP as the product and choose appropriate options in the other lists.
3. Click the Search button at the bottom of the dialog box.

4. One or more tutorials will be listed in the search results. Click on the link to the tutorial that
looks most interesting to you and use the information provided to write a summary of the fea-
tures the tutorial offers. (Do not download the tutorial without your instructor’s permission.)

PROJECT 2-3

1. Open the Windows Help and Support feature from the Start menu.

2. Click on the topic What’s new in Windows XP and continue following links until informa-
tion about new features in Windows XP opens in the right panel.

3. Click on the link Related Topics for more new features.

=

Read the information and make a list of some of the new features of the operating system.
You should include at least five new features and what they do in your list.

~* TEAMWORK PROJECT

In your office, several people share one computer and each must log on using his or her own
user name to start Windows. Recently, some workers have noticed that they are missing data,
files are not where they should be, and their standard desktop sometimes looks a little different.
There is some concern that workers are logging on using other user names. Working with two
coworkers, research passwords in the Help and Support feature and online and then write a
report suggesting how the computer users can select and use a password that will prevent unau-
thorized access to individual files and settings.

CRITICALTpinking

In two weeks your computer will be upgraded to Windows XP Professional. This will be your
first exposure to this operating system, and you would like to be prepared for the transition.
Develop a list of off-line research resources where you can explore the vocabulary and basic pro-
cedures of running a Windows PC as well as develop an understanding of some of the pros and
cons of desktop automation. These resources can include people, bookstores, and broadcast
media. Access at least one of these resources, and write a summary of your findings.
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CHANGING SETTINGS
CUSTOMIZING THE E

OBJECTIVES VOCABULARY

Upon completion of this lesson, you should be able to:

Background
B Understand the settings on the Control Panel. Control Panel
B Apply a predefined theme to the desktop. Desktop shortcuts
B Change the Windows desktop background. Desktop theme
m Customize the icons on the desktop. Internet Explorer
B Clean up your desktop. by Gempuiier
. . . My Documents
B Explain what a shortcut is and how it is used.
My Network Places
B Create and delete shortcuts.
Shortcut
B Assign a shortcut key to a shortcut. Wizard
[ |

Add a program to the Quick Launch bar.

Estimated Time: 1 hour

Windows programs run on the desktop, and objects are placed on the desktop. When you
install Windows XP, the original desktop you see may not be the exact desktop you want, but
you can customize it to suit your personal tastes. You can also customize the taskbar and Start
menu. In addition, you will learn how to use the Control Panel to adjust settings for hardware,
find system information, schedule routine maintenance, and change user account information.
Another way to customize your desktop environment is to add shortcuts. If you use particular
programs or documents frequently, you will learn how to create shortcuts for them so you can
access them quickly and easily.

The Control Panel

1-3.3.1
1-3.3.2
1-3.3.4
1-3.3.5

ou can open the Control Panel, which you will use to change settings on your computer
and customize the display, by selecting it on the Start menu. Notice that the Control Panel win-
dow, shown in Figure 3-1, has two panes like the Help Viewer and other windows we have seen.
The left pane includes a list of tasks you can choose quickly, and other places you can look for
information about the Control Panel and Windows. The right pane has nine categories you can
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pick to change settings and display options. Following are the categories and what you can do
with each of them:

B Appearance and Themes: Change the background, screen saver, or desktop items; customize
the Start menu and taskbar; apply a theme to your display; change the screen display resolu-
tion or colors.

B Network and Internet Connections: Create a small office or home network; change net-
work, Internet, and phone settings.

B Add or Remove Programs: Install, change, or remove software and Windows components;
see a list of installed software; control access to certain programs.

B Sounds, Speech, and Audio Devices: Change speaker volume and other settings for audio
and speech devices; change the sound scheme or individual sounds made by the computer.

B Performance and Maintenance: Enable energy-saving features; compress the data on your
hard disk drive; schedule routine maintenance tasks, such as disk cleanup and antivirus
checking; find system information.

B Printers and Other Hardware: Change settings for printers, keyboard, mouse, game con-
trollers, modems, scanners, and cameras; identify the hardware devices on your computer
and if they are running properly.

User Accounts: Change user accounts and passwords; change a user’s e-mail profile.

Date, Time, Language, and Regional Options: Change the language your system uses or
the date, time, or time zone; change the way numbers, currency, dates, and times are for-
matted and displayed.

B Accessibility Options: Adjust hardware and operating system settings for users with vision,
hearing, and mobility disabilities.

FIGURE 3-1
The Control Panel in the default Windows XP Category view

E- Control Panel

File  Edit View Fawaorites Tools Help #

eBack &7 Q [_% pSearch lE:‘ Falders -

Address gﬁCuntml Panel | B Go

Pick a category

= )

| Y Appearance and Themes Printers and Other Hardware
-

See Also ¢ 3 N>

3 switch to Classic view

‘ wWindows Lpdate y:
@) Help and Suppert - Network and Internet Connections User Accounts

€} Other Contral Panel —
Options _
" s Rermore Dhustanc: Datg, Time, Language, and Regional
Options

Al O} Sounds, Speech, and Audio Devices Accessibility Dptions

y Performance and Maintenance

If you are working on a networked computer, you may not be allowed to change all the
Control Panel settings. The network administrator can restrict access to some settings to prevent
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unauthorized users from making changes that can affect other users in a network, such as creating
a new user account or altering regional or language settings. Some hardware settings that control
how peripherals (printers, modems, and so on) are allocated in a network may also be protected
so that changes made by one user will not affect the entire network.

S TEP-BY-STEP 3.1

1. Click the Start button, and then click Control Panel in the Start menu. @
2. Select the Performance and Maintenance category in the Pick a category area (the win-
dow’s right pane).
3. In the Performance and Maintenance window, find the
Pick a task section and click the See basic informa- m
tion about your computer link. If your Control Panel window is
set to Classic view instead of the
4. The System Properties dialog box opens. If the default Category view, double-
General tab is not open, click on it to open it. You will click the System icon to open the
see information about the version of Windows you are System Properties dialog box.

using under the System heading.

. Click OK to close the dialog box.

. Leave the Control Panel window open for the next Step-by-Step.

\f}j: Technology Timeline

your trip. To purchase items during your journey, you must convert your Michigan dol-
lars to Ohio marks, Kentucky pounds, Tennessee lira, and Georgia francs. It would be
inconvenient, and also expensive, because every time you converted the money, the
money changers would charge you a fee. This is what tourists traditionally experienced
when they traveled in Europe. They had to convert their money to another currency
every time they crossed a border. Imagine how difficult it would be to keep track of
transactions in financial reports with so many different currencies to convert and differ-
ent symbols to represent them.

was first introduced in electronic trading—business transactions completed without
cash. In January 2002, euro notes and coins started circulating. The changeover to a
single currency affects banks, businesses, and consumers. The euro symbol now
appears in banks, on financial statements, and on retail price tags. Technology has
kept up with the new era. Windows XP allows users to change the default currency for-
mat to euros and many applications provide full support for entering, displaying, and
printing the euro symbol and for working with values in euro currency.

FORMATTING FOR EUROS

Imagine driving from Michigan to Georgia and needing five different currencies for

In 1999, 11 European countries embraced one currency unit—the euro. The euro
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T& Changing Control Panel Settings

1-3.3.3
1-3.3.5

52

Y ou now know many of the settings that can be configured using the Control Panel. Let’s
look more closely at when you would want to change settings and how to do it.

The computer uses its internal clock to display the correct time, even correcting for Daylight
Savings Time, but you may need to change the clock for some reason. For example, if you have a
notebook computer and you travel from the west coast to the east coast for an extended stay, you
would want to change the time zone setting to correct the time displayed. You can even configure
your system to automatically synchronize the time with an Internet time server. Files and folders
are date- and time-stamped when you create them and modify them, so having the computer’s
clock set accurately can be important. Think about any change you make and consider the con-
sequences of the change before you alter a setting. For example, you want files to be date-
stamped correctly; therefore, if you set the wrong date or time, you will have inaccurate and
misleading information associated with files.

Other settings that you may want to change include the speaker volume control or how the
mouse or keyboard works. Sometimes small adjustments can make a computer much easier and more
efficient to use. If you are one of several users of one computer, remember to check with a supervisor
or other users before making changes. Only make changes if they are needed. It’s a good idea to make
a note of the original settings so that changes can be modified or reversed if necessary.

S TEP-BY-STEP 3.2

. Click the Back button in the toolbar to return to the Pick a category window. Select the Printers
and Other Hardware category in the Pick a category area.

2. In the Printers and Other Hardware window, click Mouse

in the or pick a Control Panel icon area of the window. m—

3. The Mouse Properties dialog box opens. You will see In Classic view, simply double-
| tabs with inf . b h includ click the Mouse icon to open
§evera tabs with in ormatlonq out the mouse, mc;u - the Mouse dialog box, and click
ing how the buttons are configured, how the pointer the Printers and Faxes icon to
appears, and how the “Fast Wheel” scrolls through a open the associated dialog box.

document. Click each tab to view the information.

4. Click OK or Cancel to close the dialog box without changing any settings.

5. You will be back in the Printers and Other Hardware window again. Click View installed printers or fax
printers in the Pick a task section to open the Printers and Faxes window. The available printers and
faxes appear in the right pane, and the left pane lists tasks under one or more heading.

6. Click Add a printer in the Printer Task pane. The Add Printer Wizard will open.

7. In the Add Printer Wizard, you can read information about installing a printer. Read the text and then
click the Next button.

8. Click the Next button in the new dialog box to have the Wizard search for a newly installed printer.
Since no printer has been installed, you will see a message that says no new printer was found. Click
the Cancel button to close the Add Printer Wizard.

9. Close the Printers and Faxes window and then close the Control Panel window.
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You can also change some settings by double-clicking the appropriate icon on the right side
of the taskbar. Different icons may appear on your taskbar depending on the way your taskbar
has been customized. For example, click the time display to open the Date and Time Properties
dialog box, and if you see an icon that looks like a bullhorn, you can click it to open the Volume
Control dialog box and then adjust the speaker volume. Other icons may open control network
connections, printers, and other hardware, depending on what is installed on your computer.

S TEP-BY-STEP 3.3

1. Double-click the time display at the right on the taskbar to open the Date and Time Properties dialog
box, as shown in Figure 3-2.

FIGURE 3-2
Date and Time Properties dialog box

Date and Time Properties

Date & Time.l Tirme Zane || Internet Time |

Date Time

. .
1z 3 4 9 } “
5 6 7 8 9 10 11 : /

12 13 14 15 16 17 13 "._ y
19 20 21 22 23 24 25 ul
26 27 H§ 29 30

] eEels
ZUES0ERM |3

Current time zone: Eastern Davlight Time

[. [o]4 ] [ Cancel ] Apply

2. Click on each of the three tabs, Date & Time, Time Zone, and Internet Time, to view the different
settings you can adjust.

3. Click the Date & Time tab and you will see the current month and year displayed in drop-down list
boxes, and the current date shaded or highlighted in a calendar grid on the left and a clock with a
second hand, and the current time displayed below it on the right.

4. Click on any other day in the calendar grid to select it. Notice the highlight has changed to the new date.

5. Click on the up arrow next to the time displayed in the text box on the right. Notice that the hours
number is highlighted, and it increases by an hour every time you click the arrow.

6. Click the Cancel button to close the dialog box without changing the settings.

7. Double-click the icon that looks like a bullhorn on the right side of the taskbar to open the Volume
Control dialog box. If this icon does not appear on your taskbar, skip steps 7 to 9.

8. In the Volume Control panel, use the slide control to make the volume just a little louder. You may
hear a sound when you adjust the setting.

9. Click the Close button to close the dialog box and save the change you made to the vol- @
ume setting.
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The Desktop

1-3.2.5

The first thing many people want to do when they start using Windows is to customize the
desktop to better suit how they work. For example, when Windows is first installed, the background
that covers your desktop is usually a picture of a green hill beneath a blue sky with white clouds.
(The name of this background is Bliss.) You can change the background to another picture or pat-
tern included with Windows, or you can add your own photograph or artwork. You can also select
a theme, which is a coordinated design that carries through all the elements of your desktop and
window, changing the colors of windows elements and highlighting and the way icons appear. A
screen saver may be included in a theme, or you can choose a different screen saver from Windows’
selection, or install a new screen saver program.

The desktop is your work area, and it’s easy to customize it just like you would a “real” desk,
by adding pictures, rearranging the items you use, making it easy to reach items you use fre-
quently, and even cleaning it up occasionally!

Customizing the Desktop

1-3.2.5

54

To change the way the desktop looks, you select the Appearance and Themes category in
the Control Panel and then click the Display icon to open the Display Properties dialog box.

FIGURE 3-3
Display Properties dialog box

Display Properties

Themes | Desktop | Screen Saver || Appearance | Settings |

Atheme is a background plus a set of sounds. icons, and other elements
to help you personalize your computer with one click.

Windows XP theme

Theme:

Windows XP Delete

Sample:

Example of
current theme

[ ok ][ cancd |[ ppy |

As you see in Figure 3-3, the Display Properties dialog box has several tabs you can use to
change the appearance and the behavior of your desktop.
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B The Themes tab assigns a predefined set of icons, fonts, colors, sounds, and other window
elements to your desktop. Collectively these elements are called a desktop theme and give
the desktop a unified and distinctive look.

B The Desktop tab offers you a selection of pictures and graphics to use as a background on
your desktop. You can use one of the backgrounds that come with Windows or create one
of your own.

B The Screen Saver tab permits you to display static or moving graphics or a blank screen
when your system is idle.

B The Appearance tab controls the colors, fonts, and
sizes of various screen elements. You can change -
the appearance of these elements by selecting from m—
a set of predefined schemes or by creating your Right-clicking an empty area on

own scheme. your desktop (a place where
there is no folder or icon) and
clicking Properties on the short-

B The Settings tab allows you to change the resolu-

tion and the number of colors used by the display, cut menu will also open the
change the display type, and change other display Display Properties dialog box.
characteristics.

Selecting a Desktop Theme

Using the Themes tab, you can quickly modify your desktop background by selecting from a
set of predefined themes. If your computer has other users with their own user accounts, each
person can have a different theme.

To apply a new desktop theme, simply use the drop-down menu (beneath the word Theme)
to select one of the preconfigured themes (see Figure 3-4). The themes that are listed in your
Theme drop-down list may differ from the ones in Figure 3-4, but there will probably be several
choices in the list. When you click a theme, the new background will appear in the sample win-
dow in the center of the Display Properties dialog box. Click the Apply button; after a short wait,
the new theme will be set on the desktop.

FIGURE 3-4
Theme drop-down list
The default theme
. . Windows XP “
from previous versions To access themes

Mew Theme

of Windows ﬁ Currert Theme from the Internet

Windows Classic
More themes online. -
Browse...

Note

If your computer has an Internet
connection, you can access a
number of themes from the
Microsoft Web site by clicking
the More themes online option
on the drop-down list.
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S TEP-BY-STEP 3.4

1. Open the Control Panel and click the Appearance and

Themes link. m—

. \ . . . In Classic view, double-click the
2. Click the Display icon to open the Display Properties Display icon to open the Display

dialog box. Properties dialog box.

3. Select the Themes tab if it is not already selected.

4. On a sheet of paper, write the name of the desktop theme that is currently displayed in the Theme
list box.

5. Click the Theme drop-down list arrow, and then select Windows Classic if it is not already selected.
If it is already selected, select one of the other themes in the list.

6. Click the Apply button. Your theme will take effect after a short wait. The new desktop background
will appear in the Sample window in the Display Properties dialog box and you may see a change in
the Active Window displayed there also.

7. Click the Theme drop-down arrow, select the desktop theme that you wrote on your paper in Step 4,
and then click Apply. After a short wait, your desktop background will return to its former appear-
ance. Leave the Display Properties dialog box open for the next Step-by-Step.

Setting a Background Design

You can change a theme’s settings by making modifications to the other tabs available on the
Display Properties dialog box. For example, to change the background design, click the Desktop
tab and select one of the backgrounds. You can select from Windows’ preexisting backgrounds,
which are listed on the Background list box, or you can use other graphic files (for instance, from
a digital camera) as your background. By default, the background is set up to stretch across your
screen so it takes up the entire desktop area. You can center the background on the desktop or
tile it to fill the entire desktop. You select the option from the Position drop-down list box.

TEP-BY-STEP 3.5

1. Click the Desktop tab.

2. Select the Windows XP background:

a. Click the scroll down arrow in the Background list box until the Windows XP option appears, and
then select it.

b. Notice that a preview of your selection is displayed in the monitor graphic in the upper portion of
the Desktop tab.

¢. Verify that the Stretch option is displayed in the Position drop-down list box. The Windows XP back-
ground is a picture file, and by default, all picture files are stretched to cover the entire desktop.
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STEP-BY-STEP 3.5 Continued

3. Tile the background on the desktop:
a. Click the Tile option from the Position drop-down list.

b. Click the Apply button to reset the background. Notice that the background now fills the desktop
by repeating the graphic.

4. Click the Stretch option from the Position drop-down list, and then click the Apply button to reset the
background. Do not click the OK button. Leave the Display Properties dialog box open for the next
Step-by-Step.

Windows XP can display any picture or graphic file (usually files with a GIF, JPG, or BMP
extension) as a background. If you have picture files already stored on your computer, you can
simply browse and select the desired picture. You can also create your own graphic in the
Windows Paint program or some other graphics program and use it as a background.

S TEP-BY-STEP 3.6

1. Use the Flowers file in the Lesson 3 folder of the data files as a background:
a. Click the Browse button on the Desktop tab to open the Browse dialog box.
b. Select the drive and folder that contain your data files.

¢. Double-click the Lesson 3 folder, and then double-click the Flowers.jpg file. The Browse dialog box
closes, and the Display Properties dialog box reappears.

d. Verify that the Stretch option is selected from the Position drop-down list.
e. Click the Apply button to set the background.

2. Reset the background to Windows XP:
a. Scroll the Background list box, locate the Windows XP option, and click it.

b. Click the Apply button to set the background to Windows XP. Leave the Display Properties dialog
box (Desktop tab) open for the next Step-by-Step.

Customizing the Icons on Your Desktop m_

The Customize Desktop button toward the bot- You can download a picture or
tom of the Desktop tab provides a convenient way ci el froi dne Gl avd use
f to select which Windows program icons are 't as a background. Simply right-

or you to se program ; click the picture or image you
to appear on your desktop and to determine which want to use as a background
icons are used to represent those programs. Click and click Set As Background.
this button, and the Desktop Items dialog box opens
(see Figure 3-5). This dialog box contains a General

and a Web tab.
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FIGURE 3-5
The Desktop Items dialog box

Desktop Items

General | Web |
Desktop icons
[ My Documents [ My Network Places
] My Computer O Intemet Explarer

My Computer My Documents My Network  Recycle Bin - R
Places Fully ¢

< i | >

Change lcon... ] ’ Restore Default ]

Desktop cleanup

Desktop cleanup moves unused desktop items to a folder.

[1Run Desktop Cleanup Wizard every 60 days

Clean Desktop Now

[ ok J[ cancsl ]

On the General tab (see Figure 3-5), you can select the desktop icons you want to appear by
checking one or more of the check boxes: My Documents, My Computer, My Network Places,
and Internet Explorer. These icons are discussed in detail below.

B My Documents is your personal folder where you can save the files you create and use. By
default, the My Documents folder contains two additional personal folders: My Pictures
and My Music.

B My Computer displays the contents of your computer. You can see the hardware devices,
resources, programs, and files that are stored on your computer. My Computer also pro-
vides information about different system resources, such as the size of the hard disk and
how much space is available on it. You can also use My Computer to format disks and to
run applications. (You may recall that My Computer is also accessible from the Start menu.)

B My Network Places lists all of the computers on your network, if you are connected to a
network. It permits you to browse through files on a networked computer.

B With Internet Explorer, you get a fast, personalized Web browser with communication
capabilities including sending and receiving e-mail, connecting to the Internet, designing
your own Web site, and teleconferencing.

Just below the Desktop icons, you will see a window showing the default icons that are used
for each of these items, as well as the Recycle Bin icon that is placed on your desktop by default.
If you want to use a different icon for any of these items, click the item you wish to change, click
the Change Icon button, and select a different icon from the choices provided. If you change your
mind or don’t like your choice, just click the Restore Default button to return to the Windows
XP default icon settings.
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S TEP-BY-STEP 3.7

. Click the Customize Desktop button. The Desktop Items dialog box (Figure 3-5) is displayed.

2. Click the General tab to verify that it is in the foreground.

3. Display the My Documents and My Computer icons on your desktop:

a. Click the My Documents check box in the Desktop icons area. (This will place a check mark in the
check box.)

b. Click the My Computer check box.
c. Click the OK button. The Desktop Items dialog box will close.

4. Click the Apply button on the Display Properties dialog box to place the selected icons on your desk-
top. Do not click the OK button on the Display Properties dialog box.

5. Change the My Documents desktop icon:
a. Click the Customize Desktop button to display the Desktop ltems dialog box.
b. Click the My Documents icon in the display window, and then click the Change Icon button.

¢. Click the folder icon shown in Figure 3-6, and then click the OK button. Notice that the icon
changes in the display window.

FIGURE 3-6
Folder icon

O

d. Click the OK button on the Desktop Items dialog box, and then click the Apply button on the
Display Properties dialog box. Notice that the icon on your desktop has changed to your selection.

6. Remove the My Computer icon from your desktop:
a. Click the Customize Desktop button to display the Desktop Items dialog box.

b. Click the My Computer check box to deselect (uncheck) it, leave the My Documents check box
checked, and then click the OK button.

c. Click the Apply button on the Display Properties dialog box. Notice that the My Computer icon is
no longer displayed on the desktop.

d. Close the Display Properties dialog box and then close the Control Panel or the Appearance and
Themes window if necessary.

Customizing a Toolbar

The standard toolbar is the row of buttons below the menu bar on most windows. Other
toolbars appear if you select them in the Toolbars submenu of the View menu. You can easily
change the buttons that appear on any toolbar. For example, to change the toolbar in the My
Documents window, open My Documents from the desktop. Click on the View menu, and then
select the Toolbars option. (The right-pointing arrow tells you a submenu will open.) When you
select the Customize option on the Toolbars submenu, the Customize Toolbar dialog box
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appears. The dialog box has two list boxes: Available toolbar buttons and Current toolbar but-
tons, as shown in Figure 3-7. The Available toolbar options list box on the left lists the types of
buttons available to place on the toolbar. The Current toolbar buttons list box on the right lists
the buttons that already exist on the toolbar. To add buttons to the toolbar, select a button from
the list box on the left and then click the Add button. To remove buttons from the toolbar, select
a button from the right and click the Remove button.

You can change the order in which the buttons appear on the toolbar by selecting a button in
the Current toolbar buttons list box and clicking the Move Up button or the Move Down button
to change the button’s position in the list box.

FIGURE 3-7
The Commands tab of the Customize dialog box

Customize Toolbar

Available toolbar buttons: Current toolbar buttons: [ Close ]
| Separato ~ O search A
Reset

| Stop = | Folders

2 3

@ Refresh Separator

A <- Remove )
Home - Yiews =

\—IP E j tove Up
|l Map Drive Separator L

..'X o v v Mowe Dawn
Text options: |Selective text on right hd |
Icon options: |Large icons L |

Cleaning Up Your Desktop

Windows XP provides a number of utility programs that help you perform a task quickly and
easily. Each of these programs is called a Wizard and performs a special function, such as the
Add Printer Wizard you encountered earlier in this lesson. For example, as you use work, you
will place icons on your desktop. Because these icons function as shortcuts to an application or a
document, they are often referred to as desktop shortcuts. (You will learn how to create shortcuts
in the next section.) Windows XP contains a Desktop Cleanup Wizard that can check your desk-
top to see which desktop shortcuts you have not used during the previous 60 days; it then lets
you decide if you want to remove them. The desktop shortcuts you remove are moved to an
Unused Desktop Shortcuts folder from which you can recover them at any time.

Look again at the General tab on the Desktop Items dialog box shown in Figure 3-5. Notice
the Desktop cleanup area at the bottom of the sheet. In this area, you can set the Desktop
Cleanup Wizard to run automatically every 60 days, or you can run it any time by clicking the
Clean Desktop Now button.

Using Shortcuts

1-3.24

60

A shortcut functions as a pointer to an application or a document file, wherever the file is
located. When you double-click the shortcut icon, you’re opening the actual item to which the
shortcut is pointing. The shortcut is represented by an icon on your desktop. A shortcut icon is
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identified by a small arrow in its lower-left corner (see Figure 3-8). Shortcuts save time because
you don’t have to open and browse through several folders to find the file you need.

FIGURE 3-8
Shortcut icon

Identifies this as
a shortcut icon

You can create a shortcut by dragging a file to the desktop or by using the Create Shortcut
command on the File menu. Shortcut menus also appear when you right-click a file or folder on
your desktop, in the right pane of a folder window, or when you right-click an empty space on
the taskbar or desktop.

Creating a Shortcut Using Drag and Drop

If you can display an item in the My Computer window, you can create a shortcut for it by
dragging and dropping an item to the desktop with the right mouse button:

m Using the right mouse button, right-drag the item (file, program, folder, printer, computer)
from its current location to wherever you want the shortcut to appear.

Drop the item where you want it by releasing the mouse button.
A shortcut menu appears, giving you several options. Click Create Shortcuts Here.

The icon appears with the shortcut arrow and a default name.

You may want to change the shortcut’s default name to something different. To rename it,
right-click the shortcut’s icon to display the menu shown in Figure 3-9. Remember that you can
often open a task-specific shortcut menu by right-clicking an icon or text; in this case, the short-
cut menu options relate to creating shortcuts. Choose Rename, and key the new name in the
shortcut icon’s text box. You can use this shortcut menu for a number of tasks, such as deleting
a shortcut or changing its properties.

FIGURE 3-9
The shortcut menu for creating and managing shortcuts

Open

Print

Edit

Oipen With 3

Send To »

Cut
Copy

Create Shorkout

Delete

Rename

Properties m—
If you use the left mouse button
to drag a file from a folder on
the C drive to the desktop, you

will move the file and its icon to
the desktop.
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S TEP-BY-STEP 3.8

1. Open My Computer from the Start menu.

2. Locate the Assignments folder where you saved the file called Hobby created in Lesson 5.

3. Make sure that part of your desktop is visible, and using the right mouse button, drag the Hobby doc-
ument file icon to the desktop. Release the mouse button.

4. Select Create Shortcuts Here from the shortcut menu. The Hobby document shortcut appears on
your desktop.

5. Rename the shortcut:
a. Right-click the Shortcut to Hobby icon.
b. Select Rename from the shortcut menu. Notice that the icon’s name is now highlighted and has
a blinking insertion point.
¢. Key My Shortcut and press Enter to rename the icon.

6. Close the My Computer window.

Creating a Shortcut Using the File Menu

You can also create a shortcut by selecting the item for which you want (a file, program,
folder, printer, or computer) to create the shortcut in My Computer. Then from the File menu
select Create Shortcut. Resize the window so you can see the desktop. A shortcut icon for the
item appears as the last item in the My Computer window. Drag the new shortcut icon to the
desktop. Then you can rename it—as you have already learned.

Assigning a Shortcut Key to a Shortcut

A shortcut key is a keystroke combination that runs a program or opens the dialog box to
which it is linked. For example, if you assign the shortcut key Ctrl + Alt + N to your My
Shortcut, your new shortcut key will then open the Hobby document. You assign a shortcut key
in the shortcut’s Properties dialog box, which is accessible from the shortcut menu. You make the
assignment by pressing and holding the Ctrl key and then pressing the key you want to complete
the shortcut keystroke combination. When you press the Ctrl key, the combination Ctrl + Alt +
appears in the Properties dialog box. It ends with + because it is waiting for you to complete the
shortcut. Once you select OK, the shortcut keystroke assignment is made, and anytime you press
those keys, you will open the document.

You can activate a shortcut in two ways: Double-click the shortcut icon, or issue the shortcut
key combination.

S TEP-BY-STEP 3.9
1. Right-click the My Shortcut icon.

2. Select Properties from the shortcut menu. The My Shortcut Properties dialog box appears.
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STEP-BY-STEP 3.9 Continued

3. Make sure the Shortcut tab is displayed as shown in Figure 3-10.

FIGURE 3-10
Shortcut tab in the My Shortcut Properties dialog box

My Shortcut Properties

General -Shortcut |

Iy Shortout
[#]

Target bype:  Texk Document

Target location:  WINDOWS

Targek:

Start in: | CWINDOWS |

Shortcut key: |N0ne |

Run: |N0rma| window B |

Comment: | |

[ Find Target... ] [Change Icon... ] [ Advanced. .. ]

L (o4 ] [ Cancel Apply

4. Click in the Shortcut key text box.

Computer Conc Fq

5. Press and hold down Ctrl, press n, and then release If Windows is already using

Ctrl. The shortcut key Ctrl + Alt + N is displayed in the your selected keystroke combi-
Shortcut key text box. nation for another shortcut, it
will still allow you to make the
6. Click the OK button to save the shortcut keystroke assignment. When you enter

the keystroke combination,

cgmblnatlon, and close the My Shortcut Properties however, Windows will run the
dialog box. other shortcut. In this case,
just open the shortcut’s
7. Double-click the My Shortcut icon. Did the Hobby doc- Properties dialog box and
ument open? select a different keystroke

combination.
The letter name of your hard
disk may appear different from

I . that shown in the Target and
9. Issue the shortcut keystroke combination Ctrl + Alt + N: Siar i e bares i

a. Press and hold down Ctrl. Figure 3-10.
b. Press and hold down Alt.
c. Press n, and release all keys.

8. Close the Hobby document window.

10. The Hobby document once again opens. Close the document.
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Which method do you prefer—double-clicking the icon or issuing the shortcut key? You
probably found the first method simpler, but as you become more familiar with creating short-
cuts, you will see that shortcut keys are very useful when the shortcut is not in view or if you pre-
fer to keep your hands on the keyboard.

Deleting a Shortcut

Like most Windows elements, shortcuts can be deleted. There are several ways to delete a
shortcut:

B Select the shortcut, then press the Delete key.
m Right-click the shortcut, and then select Delete from the shortcut menu.
® Drag and drop the shortcut in the Recycle Bin.

If you double-click the icon or issue a shortcut, Windows displays a message box asking you to
confirm the deletion. Deleting a shortcut deletes only the shortcut, not the file to which the short-
cut points. If you drag the shortcut to the Recycle Bin, no confirmation message box appears; the
shortcut is simply moved to the Recycle Bin where it will remain until the Recycle Bin is emptied.

Adding a Shortcut to the Quick Launch Bar

With Windows, you have another choice for shortcuts: The Quick Launch bar on the taskbar
(see Figure 3-11). Always visible, the Quick Launch bar is great for those items you need to reach
fast. If you don’t see the Quick Launch bar, right-click in an empty part of the taskbar, point to
Toolbars, and then click Quick Launch.

FIGURE 3-11
Quick Launch bar

To add a button to the Quick Launch bar, drag a program, document, or desktop shortcut
icon to the Quick Launch bar. To remove a button from the Quick Launch bar, right-click the
shortcut and then select Delete from the shortcut menu.

SUMMARY

In this lesson, you learned:

B The Control Panel allows you to find information about system settings, change display
options, and customize your desktop.

You can modify your desktop using the Display dialog box tools and options.

You can select from Windows’ existing themes or choose a different background on the
Background tab.

m  Windows comes with a number of preexisting desktop themes that give your desktop a uni-
fied and distinctive look. A picture can be tiled to fill the whole screen, centered on the
screen, or stretched across the screen.
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You can use most any picture or graphic file as a background. For example, you might take
a photograph on a digital camera or download a graphic from the Web and then use it as a
desktop background.

The Desktop Cleanup Wizard is used to remove any unwanted or unused desktop shortcuts
from the desktop.

A shortcut functions as a pointer to a file—wherever it is located. Double-click the shortcut
icon to open the actual item to which the shortcut is pointing.

You create a shortcut by dragging and dropping or by using the Create Shortcut option on
the File menu. When you no longer need a shortcut, it can be deleted without impacting the
original instance.

You can add a shortcut key to a Windows shortcut. A shortcut key is a keystroke combina-
tion that runs a program—or in this case, runs the Windows shortcut to which it is linked.
Shortcut keys to Windows shortcuts always use Ctrl + Alt + and one additional character.

You can place a program, document, or desktop shortcut icon that you plan to use often on
the Quick Launch bar.

VOCABULARYRepiew

Define the following terms:

Background Internet Explorer My Network Places
Control Panel My Computer Shortcut
Desktop shortcuts My Documents Wizard

Desktop theme

REVlEWQuestions

TRUE/FALSE

Circle T if the statement is true or F if the statement is false.

T

T

F 1. The Background tab in the Display Properties dialog box lets you change the col-
ors, fonts, and sizes of various screen elements.

F 2. By default, your desktop’s background is a solid color.

F 3. Even though other users share your computer, you must all have the same theme
for your desktops.

F 4. Windows XP can display any picture or graphic file with a GIE, JPEG, or BMP
extension.

F 5. Right-clicking a shortcut icon displays the shortcut menu.
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MULTIPLE CHOICE
Circle the best response for each of the following statements.

1. You can create a shortcut by using the Create Shortcut commandonthe _ menu
in My Computer.
A. Insert
B. Help
C. View
D. File

2. A(n) __ isa keystroke combination that runs a program or opens the dialog box
to which it is linked.
A. icon
B. shortcut key
C. Ctrl key
D. Wizard

3. The ___ tab in the Display Properties dialog box that lets you assign a predefined
set of icons, fonts colors, sounds, and other window elements to your desktop.

Settings

Themes

Appearance

Desktop

SOm»

4. A ___ isa utility program provided by Windows that helps you perform a task
quickly and easily.
A. Quick Launch
B. Control Panel
C. Shortcut
D. Wizard

5. Aln) — isrepresented by a small arrow in the lower-left corner of its icon.
A. dialog box
B. screen saver
C. shortcut
D. desktop

PROJECTS

PROJECT 3-1

Before you begin, ask if your instructor wants to see the background you create in this project.
1. Open the Control Panel and click the Appearance and Themes link.

2. Click the Display icon to open the Display Properties dialog box. (If your Control Panel
appears in Classic view, double-click the Display icon to open the Display Properties dia-
log box.)
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3. Click the Themes tab if necessary, and write down the name of the desktop theme that is
currently displayed in the Theme list box.

4. Modify the theme:
A. Click the Desktop tab, select the Ascent Background, and then click the Apply button.
B. Click the Themes tab, click Save As, key Project 3-1 Theme in the File name textbox,
and then click Save.

5. Click the arrow in the Themes list box and verify that the Project 3-1 Theme is displayed in
the list.

6. Delete the Project 3-1 Theme:
A. Select Project 3-1 Theme from the Theme list box.
B. Click the Delete button.

PROJECT 3-2

1. Verify that the Quick Launch bar is displayed. If not:
A. Right-click a clear area on the taskbar, then select Toolbars from the shortcut menu.
B. Select the Quick Launch option.

2. Move the My Shortcut icon on your desktop to the beginning of the Quick Launch bar:
A. Right-drag the My Shortcut icon from the desktop to the Quick Launch bar.
B. Select the Move Here option from the menu.

3. Test the shortcut:
A. Click the My Shortcut icon on the Quick Launch bar to open the Hobby document.
B. Close the Hobby document.

4. Delete the shortcut from the Quick Launch bar:
A. Right-click the My Shortcut icon on the Quick Launch bar, and then click Delete on the
shortcut menu.
B. Click Yes in the message box to confirm the deletion.

5. Follow your instructor’s directions to log off or turn off your computer.

PROJECT 3-3

Shortcuts are handy tools, but too many shortcuts on the desktop can make it look cluttered
and confusing. List other advantages and disadvantages of using shortcuts, including the pros
and cons of assigning shortcut keys.

E TEAMWORK PROJECT

One of your coworkers is collecting informal inventories of all employees’ computer systems.
She has requested a list of the system resources and hardware devices on your computer. Working
with another student, create a table that includes your name, the system information, such as the
computer model, operating system, and registration information, and the hardware devices con-
nected to each of your computers. In a paragraph below the table, explain where you found the
information.
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CRITICALhinking

ACTIVITY 3-1

Beyond aesthetics, is there a practical use for applying a desktop background? Include a brief
explanation in your answer. If your answer is yes, include an example of a practical application.
If your answer is no, cite an example of how a desktop background might impair productivity.
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USING WINDOWS

OBJECTIVES VOCABULARY

Upon completion of this lesson, you should be able to: Contents pane

B Define uses for Windows Explorer. Folders bar
B |dentify the parts of the Explorer window and the Search

icons used to represent drives, disks, files, and Sorting

folders.

Tree pane

B Use Explorer to view the contents of a drive or folder. Wildcard characters
B Expand and collapse the folder list. Windows Explorer
B Change the view in the Explorer contents pane.
B Sort the information in the contents pane by criteria

in the Details view.

B Display information about a file or folder in the é
Properties dialog box.

B Search for files or folders.

Estimated Time: 1.5 hour

The utility program Windows Explorer is designed to help you find, view, and manage files
easily and effectively. Explorer gives you control over the organization and management of your
files and folders. Like My Computer, which you used in earlier lessons, Explorer makes it easy to
view the contents of selected disks and folders. In earlier versions of Windows, My Computer
and Windows Explorer were separate programs. In Windows XP, My Computer and Windows
Explorer are actually the same program; you simply click the Folders button on the toolbar in
My Computer to access the Windows Explorer features. All the disk and folder maintenance
operations you use with My Computer are available in Windows Explorer. Explorer simply pro-
vides additional features to make the tasks easier and faster. In this lesson, you will learn how to
use options in Windows Explorer to control the display of files and folders.
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‘ The Explorer Window

1-3.26
Windows Explorer gives you the capability to search for files and folders, to find details

about the contents of the files and folders, and to manage them—deleting, copying, and moving
files and folders as necessary. There are three ways to start Explorer:

m  Click Start, point to All Programs, point to Accessories, and then click Windows Explorer.
B Right-click over the Start button, and then select Explore from the shortcut menu.

m Click Start, click My Computer, and then click the Folders button on the toolbar.

The right pane of the Explorer window looks similar to and functions like the My Computer
window. The major difference between the My Computer window and the Windows Explorer
window is how the left pane is used. As you can see in Figure 4-1, My Computer’s left pane con-
tains a resource bar that provides links to system tasks and your computer’s resources.

FIGURE 4-1
My Computer window

2 My Computer

File Edit Wew Favorites Tools Help ﬁ.

€D back ~ ¥ | O search [{ Folders -
Q- @ | Psaa 2

Address e My Computer v Go | Norton AntiVirus E -
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View system information
ﬁ Add or remove programs
[} Change a setting Hard Disk Drives

|3 5hared Documents  File Folder

Links to tasks
and resources Other Places

g My MNetwork Places
[E] My Documents
|3) Shared Documents

“e Local Disk (C:) Local Disk
Devices with Removable Storage

3% Floppy (A1) 3%4-Inch Floppy Disk
®oFFICELD (03) CD Drive

= Fip 250 (E:) Removable Disk
9 Control Panel
Other
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Explorer’s left pane (see Figure 4-2) contains the Folders bar, which lets you see the structure
of your folders at a glance and allows you to move and copy files by dragging them from one
pane to the other. If you’ve worked in previous versions of Windows, this pane should look
familiar to you.
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FIGURE 4-2
Windows Explorer window
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Note that with either of these windows, because they are really working from the same pro-
gram, you can alter your view to appear like the other. For example, if you are in the My
Computer window and you click the Folders button on the toolbar, the links will disappear and
will be replaced by the Folders bar. If you are in the Windows Explorer window and you click on
the Close button at the top right of the Folders panel, the Folders bar will disappear and be

replaced by the links to System Tasks and Other Places.

S TEP-BY-STEP 4.1

1. Start your computer and launch Windows XP if necessary.

2. Click Start, point to All Programs, point to Accessories, and then click Windows
Explorer. If Windows Explorer does not appear on the Accessories menu, click the

down arrow at the bottom of the menu. Leave this window open for the next Step-by-Step.

Identifying the Parts of the Explorer Window

By now, you should recognize the window features
common to many Windows XP screens. If you are new
to Windows XP, however, you may not know the func-
tion of the two panes in the Explorer window. The
Folders bar (left pane) is commonly referred to as the
tree pane. The right pane is called the contents pane.
These panes are discussed below.

Folders Bar (Tree Pane)

Computer Conc H

Windows XP continually moni-
tors the programs you use. The
programs and files that have not
been accessed in some time
will not be displayed on a menu
until you click the down arrows
at the bottom of the menu. The
menu listing will expand to show
all the options on the menu.

The Folders bar is also called the tree pane because

its hierarchical display of all objects on the desktop is like a tree’s trunk and branch system. But in
this case, the tree is upside down: Its main root (Desktop) is at the top, with folders and subfolders

branching off below it.



M1L9 C5338 33912_M1L9 C5338 33912 27/04/2010 09:21 Page 160 4@i

72

Module 1 Computing Fundamentals

Contents Pane

The display shown in the right pane (the contents pane) changes depending on the folder,
disk, or other object selected in the left pane. In other words, the two panes—tree and contents—
work together. For example, note in Figure 4-2 that Local Disk (C:) is selected. Also note that the
Address Bar says C:\, thus matching the object selected in the left pane. If the WINNT folder is
selected in the tree pane, the listing in the contents pane changes to show what’s in the WINNT
folder and the Address Bar reads C:\WINNT. Explorer’s title bar also displays the name of the
disk or folder you’re currently exploring in the contents pane.

Identifying the Icons in the Explorer Window

At the top of the tree pane is the Desktop icon. You may have to scroll to bring it into view.
This icon represents the Windows desktop, and all icons are shown in the tree pane as stemming
from the Desktop icon. Look at Figure 4-3. Note how the My Documents, My Computer, and
My Network Places icons appear below and to the right of the Desktop icon. The placement of
these icons makes it clear that these folders are subordinate to—or down one level from—the
Desktop. The graphic used for each icon gives you a clue about what is represented—a drive, a
folder, or an application file, for example.

FIGURE 4-3
Icons in the Explorer window
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Each of these icons, in turn, has icons below and to the right of them. Under the My
Computer icon, for example, you may see an icon for a floppy drive or a CD/DVD drive and an
icon for the hard drive. The hard drive icon has a number of folders displayed below and to the
right of it. These are the applications and other folders stored on the drive.

Finally, Explorer shows you whether each of these folders has subfolders within it. Notice in
Figure 4-3 the small boxes to the left of some icons. Boxes containing a plus sign (+) indicate
folders that have subfolders not currently displayed. If a box contains a minus sign (-), the
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subfolders are displayed below the folder. In Figure 4-3,
for example, the minus sign next to the My Computer m—
icon indicates that all subfolders in that folder are dis- If you are displaying the con-
played below. The plus sign next to the Shared tents of a folder for the first
Documents folder indicates that this folder contains time, you may have to click the
subfolders that are not displayed. (See the Expanding Show Files or Show the con-

and Collapsing the Tree section, which follows.) tents of this folder link in the
contents pane first.

As you can see from a careful look at the tree pane,
Explorer uses one view to show the same information
that would require several views in My Computer. You’ll find this view makes it very easy to han-
dle file-management tasks.

The contents pane also shows several types of icons, depending on the object selected in the
tree pane. Look at Figure 4-4. This figure shows that the WINNT folder has been selected. The
label WINNT is highlighted in the tree pane, and the folder icon appears to be open. The con-
tents pane shows the contents of this folder, which include both subfolders (identified by the yel-
low folder icons) and files (identified by icons other than that of a folder).

FIGURE 4-4
Displaying the contents of a folder
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i = on s _defaul - ien
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You can see the subfolders in the contents pane even when they are not displayed in the tree
pane. Being able to control each pane independently of the other gives you great flexibility when
you are copying, moving, viewing, or otherwise manipulating files.

Expanding and Collapsing the Tree

When you open Explorer, it does not display subfolders. If you want to display subfolders for
any folder, you must expand the folder list (increase the subfolder display level). To expand the
folder list, just click the plus sign in the box to the left of the folder. As the subfolders appear
below the folder, the plus sign changes to a minus sign. When you click the minus sign, you col-
lapse the folder list (decrease the subfolder display level).

Collapsing a folder makes it possible to view more objects in the tree. This is useful if you are
trying to copy or move files between different folders. Collapsing folders also makes the folder
list less cluttered, so it is easier to locate files and folders.
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. Find the drive on which the WINNT or WINDOWS folder

. Locate the WINNT or WINDOWS folder, and note

. Click the box to the left of the WINNT or WINDOWS

S TEP-BY-STEP 4.2

. Click the My Computer icon in the tree pane.

Note

On your system, the WINNT
folder may have a different
name. It may, for instance, be
called WINDOWS or Windows. If
you are uncertain, ask your
instructor for assistance. In this
and subsequent Step-by-Step
instructions, substitute the
appropriate name of your
folder wherever you see the
name WINNT.

is stored (generally drive C). If the box to the left of
the drive has a plus sign, click the plus sign (+).

whether there is a plus or a minus sign in the box to
the left of the icon.

folder icon. If the box has a plus sign, the tree will
expand, showing the subfolders below the folder; if
the box displays a minus sign, the tree will collapse.

. If necessary, click again on the box to the left of the folder icon to display the subfolders in the

tree pane.

. Notice that a number of the subfolders have additional subfolders, as indicated by a plus sign in the

box to the left of the subfolder.

. Expand the system32 folder (you may have to use the tree pane’s scroll bar to find it), and display all

of its subfolders and their subfolders:
a. Click the plus sign in front of the system32 folder.
b. Click the plus sign in front of the drivers folder.

. Click the minus sign (-) in front of the drivers folder. Notice that the drivers folder list collapses.

. Click the minus sign in front of the system32 folder and the minus sign in front of the WINNT or

WINDOWS folder. Remain in this screen for the next Step-by-Step.

Setting Explorer Options

1-3.2.6

74

Explorer’s View menu is similar to all View menus in other program windows. You can
choose to display the Standard toolbar buttons and the status bar, for example, and you can

change the view of the contents pane to Thumbnails, Tiles, Icons, List, or Details.

Views

The default view for Windows Explorer displays tiles (large icons) in the right pane, as shown
in Figure 4-5. Depending on the task and your goal, you can choose the view option to best meet

your objectives.
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FIGURE 4-5

Windows Explorer—Tiles view
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B Thumbnails: Displays the images a folder contains on a folder icon so you can identify the
contents of the folder quickly. For example, in Thumbnails view, you can see small images
of pictures stored within a folder on the folder. By default, four images will be displayed on
the folder, and the folder name is displayed under the folder icon.

m Tiles: Displays a large icon and filename for each file and provides a visual clue to the type
of file and the file contents, such as a musical note for music files or a picture for image
files. Information about the file, such as the date it was last modified or the type of file, is

displayed below the icons.

B Icons: Displays small icons with filenames
below them, generally arranged horizontally

across the screen.

m List: Provides a list of all files and folders. Displays

small icons and the filename, usually in a vertical

arrangement.

B Details: With details, you get much more informa-
tion than you do with the other view types.

Details view can show the file icon, the filename,
the file size, the associated application, the date

and time the file was created or last modified,
and other information depending on the chosen options.

Note

To change the information listed
in Details view, click the View
menu and then click Choose
Details. Click in the box to

the left of each detail name to
select it; if you want to elimi-
nate a selected detail, click
the box to deselect it. Then
click the OK button to apply
the new details.

Additionally, if a folder contains all graphic files, the Filmstrip view becomes an option as
well. With the Filmstrip view, you see a larger image than you do with the Thumbnail view and
you can scroll through all the files in the folder.
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S TEP-BY-STEP 4.3

1. On the View menu, click Thumbnails. The display now shows large icons representing folders and
files, with images on the folders that indicate their contents.

2. On the View menu, click Icons. The display now shows a horizontal arrangement of folders and files
represented by icons and titles.

3. On the View menu, click List. The display now shows a vertical arrangement of folders and files rep-
resented by icons and titles.

4. On the View menu, click Details. The display now shows a detailed list of each folder, and may include
information such as name, size, type, and date and time created or last modified (Figure 4-6). Leave
this window open for the next Step-by-Step.

FIGURE 4-6
Windows Explorer—Details view
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Sorting

To help you more easily locate files and folders, you can also sort the items displayed in a
window. Sorting is the process of creating a list organized on a specific criterion. For example,
you can sort a list of files in alphabetical order by filename, by size from smallest to largest, or by
date created or modified, from most recent to oldest files. If you are looking for a file, but you
can’t remember the name, you might remember that you worked with the file within the last few
days. Your best option is to sort by date modified, as shown in Figure 4-7. You can sort files by
any details listed in Details view, such as name, size, and type. To sort by any option, just click
the column name in Details view.
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FIGURE 4-7
Windows Explorer—files sorted by date modified
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The Toolbar
Explorer’s toolbar is similar to the My Computer
toolbar. You will see the Back, Forward, and Up navi- Computer Con E

gation buttons that help you navigate in both the tree

: The arrow that appears next to
pane and the contents pane. The Views button at the far C

the column head in Details view

right of the toolbar lets you change the way objects are indicates whether the list is
displayed in the contents pane only. The options from sorted in ascending order (arrow
the Views button are the same as those listed above: points up) or descending order
Thumbnails, Tiles, Icons, List, Details, and Filmstrip (arrow points down).

(for folders containing only graphic files). The Search
button opens the Search Companion to help you find specific files or folders, which you will
learn about later in this lesson.

Remember you can change the Standard toolbar in any window, including the Explorer win-
dow, by clicking the Toolbars option from the View menu and then selecting the Customize
option from the submenu. In the Customize dialog box, you can add or remove buttons from the
toolbar. You can also change how information about toolbar buttons is displayed. In the Text
options drop-down list, you can choose to display text identification for each button or to have
identifying text appear when you rest the mouse pointer on the button. You can also choose the
No text labels option, but you will probably find that the labels help you learn about the avail-
able toolbar commands.
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Viewing the Contents of a Drive or Folder

I5.28 Most folder and file operations require you first to identify the drive you want to use. In
Explorer, icons in the tree pane represent the available disk drives, folders, and other objects. To
select a drive, for example, click the appropriate drive icon. The drive is highlighted in the tree
pane, and its contents appear in the contents pane (see Figure 4-8).

FIGURE 4-8
Highlighting shows which disk drive is selected
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g zsvc;;nenm and Settings autoexec c driVe
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[C) OEMDRVRS
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You can also select a drive or another desktop
object (such as the Recycle Bin) by clicking the object in
the Address Bar drop-down list. This action moves you m—
fhrectly to(;he 1ob]egt in the tll;ee pane. If yolu have agery If the Address Bar is not visible
arge tree displayed, it may be easier to select an object in your Windows Explorer
this way than to scroll in search of it. screen, click on the View menu
To view the contents of a folder, click the folder in the and then open the Toolbars sub-
. . menu. A check mark appears
tree pane. The folder opens and its contents appear in the next to selected toolbars.
contents pane. If the folder has subfolders, you can dou- Select Address Bar if it is not
ble-click a subfolder in the contents pane. When you do selected.
so, the subfolder’s contents are displayed in the contents
pane and the tree pane expands to show any subfolders.
1. Click the icon of the drive where your Assignments folder is located. The contents pane shows the
contents of the disk or drive.
2. Double-click the Assignments folder in the contents pane. Notice that the folder's contents now
appear in the contents pane and that the tree pane shows the open folder under the drive icon.
3. Click the WINNT or WINDOWS folder (usually found on drive C) in the tree pane to display the
contents of the folder on your hard drive.
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STEP-BY-STEP 4.4 Continued

4. In the contents pane, double-click the system folder. (If necessary, click Show Files or Show the
contents of this folder in the contents pane.)

5. Click the View button on the toolbar and select List. Your display should resemble Figure 4-9. -

FIGURE 4-9
Contents of the system folder
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6. Click the Up button on the toolbar to select the WINNT or WINDOWS folder again.
|. ...l'

7. From the Address Bar drop-down list, select the drive that contains your Assignments folder. (If
the Address Bar is not visible, select it from the Toolbars submenu on the Views menu.)

8. Click the Close button to close Windows Explorer.

Displaying File Properties
1-3.2.6
The Properties dialog box for a file or folder in Windows displays information about the file

or folder, including the type of file, the name of the program that opens the file, the file size, the
file location, and the date the file was created and last modified. To display the properties for a
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file or folder in Windows, right-click the filename or folder in Windows Explorer, and then click
Properties. Figure 4-10 shows the properties for a Microsoft Word file named Letter.doc.

FIGURE 4-10
Properties dialog box in Windows

Letter.doc Properties

General |

@ I Lether.doc

Type of File:  Microsoft Waord Document

Cpens with: Microsaft Word Change... |

Location: CiiDocuments and SettingstAdministratoriMy Doc

Size: 19.5 KB {19,965 bytes)

Size ondisk: 32,0 KB (32,768 bytes)

Created: Today, August 26, 2002, 10:58:15 AM
Modified: Today, August 26, 2002, 10:58:16 AM
Accessed: Today, August 26, 2002

attributes: [~ Read-only [ Hidden v archive

Files created in different programs can have addi-

tional properties that are displayed in the Properties m—

dialog box within that program. For example, in addi- Vo @R @llEE SEE dhe

tion to General properties., a Microsoft Word document Properties dialog box by right-
can have Summary, Statistics, Contents, and Custom clicking any icon on the
properties, which might include the document’s author, Windows desktop. This will open
the number of words and paragraphs in the document, the shortcut menu so you can

select Properties to open the

and the name of the client for whom the document was )
dialog box.

created. Figure 4-11 shows the Summary tab of the
Properties dialog box in Word for the file Letter.doc.

FIGURE 4-11
Summary tab in the Properties dialog box in Microsoft Word
Letter.doc Properties ; - HE
General  SUMMAry |Statistics I Contents I Cuskomn I
Title: Letter
Subject: |
Author: IAdministrator
Manager: I
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& Cakegory: | i
Keywords: I
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base:
Terplate:  Mormal.dot
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S TEP-BY-STEP 4.5

. Open Windows Explorer. To do this, rightclick the Start button, and then click
M " start

2. Click the My Documents icon in the tree pane and look for a data file, such as a word-processing file,
an image (or picture) file, or an audio file. Your instructor may direct you to a specific folder to find a data
file, or you can open the My Pictures folder and find an image file in the Sample Pictures subfolder.

3. Right-click the file icon in the contents pane.
4. Click Properties. Notice which properties are displayed on the General tab in the dialog box.

5. If there are other tabs in the Properties dialog box, click on each tab and look at the information
displayed. Close the Properties dialog box.

6. Close Windows Explorer.

Finding Files and Folders

1328 T'he Windows XP Search feature allows you to find files and folders by specifying a variety

of search criteria. For example, you can search for files and folders by name, by date, by type, by
size, or by a string of text that they contain. There are three ways to access the Search feature:

B In Windows Explorer, click the Search button on the toolbar.

B If you are not in the Explorer window, click the Start button and then click Search on the
Start menu.

®m Right-click over the Start button and then select Search... from the shortcut menu.

VE7:| TECHNOLOGY TIMELINE

LOGICAL SEARCH TOOLS

In the 1840s, George Boole, a self-educated mathematician from England, developed
ways of expressing logical processes using algebraic symbols. The Boolean logic uses
words called operators to determine whether a statement is true or false. This Boolean
logic has become the basis for computer database searches. The most common opera-
tors used are AND, OR, and NOT. These three simple words can be extremely helpful
when searching for data. For example, if you search for “railroad AND models,” the
results will include documents with both words. If you search for “railroad OR models,”
the results will include the greatest amount of matches listing documents with either
word. A good way to limit the search is to search for “railroad NOT models.” The results
will then include all documents about railroads but not documents about models.
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The Search or Search Results window will open. The left pane is called the Search
Companion and offers a list of options to search. Figure 4-12 shows the Search window that
opens in the left pane when you click the All files and folders option.

FIGURE 4-12
Search Results window
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criteria below.

All or part of the File name:
A word or phtase in the File:

Look int

e Local Hard Drives (i)

When was it
modified?

What size isit?

More advanced
options

In the All or part of the file name text box, type all or part of the name of the file you want to
find. You can also use the wildcard characters (* or ?) to substitute for characters in a filename.
Use * to substitute for zero or more characters and use ? to substitute for only one character.

To search for files containing specific text, type the text you want to find in the A word or
phrase in the file text box. Use the Look in list arrow to select the drive or folder you want to
search. To specify additional search criteria, click on the down arrow button next to one of the
available search options, and then select one or more of the options to narrow your search.
Table 4-1 describes the search options available. When you are finished selecting search options,
click the Search button at the bottom of the Search Companion pane to start your search.

TABLE 4-1
Search options

SEARCH OPTION USE TO

When was it modified? Find files that were created or modified on or between
specific dates

What size is it? Find files of a specific size
Type of file Find files of a specific type, such as a Microsoft Word document
Search system folders Search in the folders that contain system information

Search hidden files and folders Search in files or folders that have the hidden attribute

Search subfolders Search all the subfolders in a drive or folder
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TABLE 4-1 Continued
Search options

SEARCH OPTION USE TO

Case sensitive Find files with upper- and lowercase letters that match the
filename search criteria

Search slow files or Search Find files stored on removable storage devices, such as a tape
tape backup backup device

S TEP-BY-STEP 4.6

. Click the Start button on the taskbar and then click Search in the Start menu.

2. Click the All files and folders option in the Search Companion (left) pane.

3. Key the name of a file from My Documents for which you would like to search in the All or part of the
file name text box.

4. Choose My Documents from the drop-down menu of the Look in field if it is not already selected.

5. Click the down arrow button next to More advanced options. Make sure that Search subfolders is
checked.

6. Click the Search button.

7. Select the file you want from the list of files and folders in the right pane. Double-click on the file to
open it.

8. Close the file.

9. Close the Search window.

SUMMARY

In this lesson, you learned:
Windows Explorer and My Computer are actually the same program in Windows XP.

When you start Explorer, you see a window with the familiar title bar, menu bar, display
window, and status bar. The display window is divided vertically into two panes—a left
pane, which displays the Folders bar, and a right pane, which displays the contents.

m The Folders bar, also referred to as the tree pane, displays all the objects on the desktop in a
hierarchical structure, and it displays the folder structure for the currently selected disk. The
contents pane displays the contents of the folder selected in the tree pane.

®m In the tree pane, the open folder is the active folder. In the contents pane, a folder icon rep-
resents a subfolder of the open folder.

83



M1L9 C5338 33912_M1L9 C5338 33912 27/04/2010 09:21 Page 172 4@i

84

Module 1 Computing Fundamentals

B Explorer’s View menu options and Views button allow you to control how files are dis-
played in the contents pane. You can select Thumbnails, Tiles, Icons, List, Details, and
sometimes Filmstrip (for graphics files).

B Sorting files in the contents pane organizes the list according to a specific criterion. You can
sort files and folders by many specifications including name, size, date modified, and type.

m In the tree pane, you can collapse (decrease the levels shown in) the tree so the folders and
subfolders do not appear. You can also expand (increase the levels shown in) the tree so it
shows folders of all levels.

B You can display the properties of a file by right-clicking the filename in the Explorer window
and then selecting Properties from the shortcut menu to open the Properties dialog box,
which provides information about the file including size, type, date, author, and other details.

B The Search feature is available in Windows Explorer by clicking on the Search button on
the toolbar, or you can access Search directly from the Start menu.

m Options in the Search Companion allow you to refine your search to find specific files or

folders.

VOCABULARYRepiew

Define the following terms:

Contents pane Sorting Wildcard characters
Folders bar Tree pane Windows Explorer
Search

REVlEWQuestions

TRUE/FALSE

Circle T if the statement is true or F if the statement is false.

T F 1. To start Windows Explorer, you select All Programs on the Start menu and then
select Windows Explorer.

T F 2. In Windows Explorer, the Folders bar is also called the contents pane.

T F 3. When viewing files as Thumbnails, you can see the date and time the file was

modified.
T F 4. To find a specific file, use the Windows Search feature.

T F 5. Aplussign next to a folder in Explorer’s tree pane indicates folders that have sub-
folders not currently displayed.
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MULTIPLE CHOICE

Circle the best response for each of the following statements.

1. Windows Explorerand __ are the same program in Windows XP.
Desktop

WordPad

My Computer

Recycle Bin

SOwE»>

2. creates a list organized on a specific criterion.
Searching

Sorting

Exploring

Tiling

SOF>

3. The left pane of Explorer containsa(n) ___ that lets you see the structure of
your folders.
A. tree
B. icon
C. link
D. menu

4. The —_ iconis at the very top of the tree pane.
A. My Computer
B. My Explorer
C. drive C
D. Desktop

5. All of the following are views you can use to display files and folders except
A. Thumbnails
B. Rulers
C. Tiles
D. List

PROJECTS

PROJECT 4-1

1. Start Windows if it is not already running.

2. Open My Computer, and then click the Folders button on the toolbar to access the
Windows Explorer Folders bar.

3. In Windows Explorer, perform the following steps:
A. Change the view to Thumbnails.
B. Change the view to List.
C. Change the view to Icons.

4. If the Address Bar is not visible, select it from the Toolbars submenu of the View menu.
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Click the Address Bar drop-down list arrow, and select Recycle Bin.

. Click the Back button to return to Windows Explorer.

5.

6

7. Click the icon that represents your computer’s hard disk in the tree pane.
8. Double-click a folder on your computer’s hard disk to view its contents.
9

. Right-click a file or subfolder in the folder to open the shortcut menu.
10. Select Properties from the shortcut menu to open the Properties dialog box.
11. Look at the information displayed about the file or folder, and then close the dialog box.
12. Click the Up button on the toolbar until My Computer appears in the Address Bar.
13. Click the Folders button on the toolbar to reopen the resource bar in the left pane.

14. Click the Close button to close My Computer.

PROJECT 4-2
1. Open Windows Explorer, and display the Lesson 4 data folder in the contents pane.

2. Open the Lesson 4 data folder to display its contents with details about the files and folders:
A. Click the Lesson 4 folder, then open the Project4-2 folder.
B. Choose Details from the View menu.
C. Open the Choose Details dialog box and select Name, Size, Type, and Date Modified if
these details are not already selected.

3. Print a copy of the Project4-2 Report Form in the Project Reports folder:
A. Click the Project Report folder to open it.
B. Verify that your printer is accessible and ready.
C. Select the Project4-2 Report Form file, and then select Print from the File menu.

4. Using the Project4-2 Report Form you printed in step 3, do the following:
A. Fill in the heading with the appropriate information.
B. Answer all questions on the Report Form using Windows Explorer to display the sub-
folders and files in the Project4-2 folder.
C. Turn the report in to your instructor if requested.

5. Close Windows Explorer.

6. [If instructed to do so, shut down Windows XP and your computer.

=Y TEAMWORK PROJECT

Working with another student, write a list of steps you would follow to use the Windows XP
Search feature to find all the JPEG image files in the My Documents folder. Then use the steps to
conduct the search individually. When you have the search results, select the List or Details view
and click the Name column head to put the list of files in ascending alphabetical order by file-
name (you may need to click the Name column head twice to put them in A to Z order). On a
piece of paper, write the total number of JPEG files you found and the names of the first three
files. Compare your results with your partner’s results. If there are differences in the list, do you
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think they are because you have different files on your computer, or because you set up the
Search criteria differently?

CRITICAL T pinking

ACTIVITY 4-1

During lunch, a coworker asked if you thought there were advantages to working with
Windows Explorer rather than My Computer. You told him you would have to think about it
and would give him an answer later in the day. Consider features that might be available in
Explorer but not in My Computer; determine what, if any, operations are easier to perform in
Explorer than in My Computer; and prepare a written response for your coworker.
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